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Introduction

Welcome to Interiors for the Apple IIGS, a flexible tool for easily
creating interior room designs. You can create your own custom room
designs or use any of the more than 2 dozen designs that you receiv-
ed with Interiors. Additional Design Your Own Home libraries are
available, and each one has more than 4 dozen pre-drawn room
designs.

Interiors is an object-oriented program. It differs from paint programs
in that furniture, and things you draw, such as lines and rectangles
for example, are treated as objects that you can manipulate. You can
quickly and easily change their color or size, move them around, rotate
them, flip them horizontally or vertically, and much more.

Commonly used furniture objects such as tables, chairs, sofas, cabinets,
and many others have already been created for you. You can place
them in your room with a single keystroke. Then, once you have ar-
ranged the top view of your room the way you want, you can choose
to view your room from any of its four sides. Interiors automatically
converts your room to a perspective side view of your choice. You
can rearrange your side view or look at your room from other sides
to study your furniture design.

Another feature, “Use Finishing Tools”, lets you customize any view
of your room. Among other things, you can change your furniture’s
color or size, use various drawing tools, or add text to your drawing.
You can also create and save your own custom furniture or color pat-
terns for later use.

Here’s a sample of features that make creating your own interior
designs a snap: fast keyboard access to pre-drawn furniture objects
for living rooms, dining rooms, bedrooms, kitchens, bathrooms, and
more; support for custom objects you design; custom room drawing
feature; automatic generation of side view designs from your top view
design; rulers which reflect real-world distances in your choice of two
scales; finishing tools that provide text in various fonts, sizes, and
styles; color blending, copying, and swapping; 48 custom patterns
with pattern editing capability.

And as an additional bonus, a paint program is included on the data
disk you received. If you need to work on your landscape design in
ways that only a paint program can, you can save your design as a
paint file and use Paint Your Own Home (see Chapter 5)

Read on to see hpw quickly and easily you can create your own custom
room designs with Design Your Own Home, Interiors.

|
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1—Getting Started

This part of the user’s guide shows how to get Interiors up and run-
ning and gives you a hands-on introduction to many of its features.

If you are at all familiar with Apple’s recommended standards for the
mouse driven desktop environment, you'll feel right at home with the
Interiors friendly human interface. If you haven’t used the mouse or
worked within a desktop environment before, please study your Ap-
ple IIGS System Disk User’s Guide.

Note: Early releases of the Apple IIGS System Disk User’s Guide don’t
have information about the desktop environment. You can get a re-
cent (spiral bound) version from an Apple dealer.

Getting Ready
Using The Mouse

This section reviews some common terms related to using the mouse.
These terms are used frequently throughout this user’s guide.

Pointer refers to the symbol, shape, or character on the screen that
moves when you move your mouse. You'll see two basic types of
pointers while using Interiors, the familiar arrow-shaped pointer and
a cross-hair-shaped pointer used for drawing. They look like this:

Often in this user’s guide you are told to position the pointer and
click. Click means to press and release the mouse button quickly.

Sometimes you may be told to double-click. This means to quickly
press and release the mouse button twice.

You'll also see the term drag. It means to press and hold the mouse
button down, then move the mouse.

Setting Your RAM disk

Interiors requires 1024K (1MB) of free memory to operate, so to en-
sure enough memory is free, go to the Control Panel and set your
RAM disk size to zero before continuing. If you need help, refer to
“Appendix C”, “Setting Your RAM Disk To Zero”.




Write Protecting Disks

You can write protect a disk to protect it from having data accidentally
changed or destroyed. When a disk is write protected, you cannot
save interior designs or any other kind of data on it. However, you
can load designs from it, or copy files on it to another disk. Before
you use the Interiors program disk, write protect it. Read on through
this section to find out how.

If you look at a 3.5” disk from the back side, you'll see a write pro-
tect tab located near the top left corner. To write protect a disk, use
a pencil or appropriate item to slide the tab upward so that the small
hole under the tab is uncovered. You can slide the tab back down
again to cover the hole if you want to save anything on the disk at
a later time.

You can use this technique to protect final data disks as well.
Remember though, the disk cannot have information written to it
until the write protect has been disable (i.e. you slide the tab to cover
the hole). An error message is shown if you try to save anything on
a disk that is write protected, so don’t write protect a working data
disk that you'll need to save your designs on. Write protecting a disk
does not protect it against physical damage, like spilling a liquid on
it, for example, so you should keep backup copies of your designs
on other disks as well.

Starting The Finder

The Finder program is provided with-Interiors on the Design Your
Own Home (DYOH) system disk. Among other things, the Finder
lets you start Interiors, make backups, initialize data disks, and copy
disks or files.

The first step to starting Interiors is to start the Finder. To do so,
insert the DYOH system disk into your drive, turn off your computer
(if it is on), wait for about 30 seconds, and turn it back on again.

Once the Finder screen appears, if you have one drive, remove the
DYOH system disk from your drive and insert the Interiors program
disk. If you have two drives, insert the Interiors program disk into
your second drive. A window with the name DYOH.Interiors at the
top of it opens automatically.

——
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If for some reason the window does not appear, you can open it
yourself. To do so, use the mouse to move the arrow pointer onto
the disk (or volume) icon that has the name DYOH.Interiors beneath
it, then double-click the mouse button.

The Interiors application icon is inside the DYOH.Interiors window
(if you had to open the window yourself, you may need to use the
window’s scroll bars to find the icon). It looks like the side view of
a room with furniture inside it and has the name Interiors beneath it.

INTERIORS

Room designs you have created and saved to disk appear with a docu-
ment icon when viewed from the Finder screen. The Interiors docu-
ment icon looks like this:

il
[ ]
MY.HOME

Note: The Finder will do much more than is covered in this user’s
guide. Please refer to your Apple IIGS System Disk User’s Guide for
detailed information about the Finder.




Making A Backup

Before you use Interiors for the first time, read this section and make
backup copies of the original disks that you received. Then put your
originals in a safe place and use the backups for everyday use. If you
damage one of your backups, you can make another one from the
original.

You need to use the Finder to make backups. If you haven'’t started
the Finder, refer to the previous section and do so, then work through
the following steps.

1. If you have one drive, remove the Interiors program disk from your
drive and insert a blank disk. For two drives, remove the
DYOH.SYSTEM disk and insert the blank disk in its place.

2. If the blank disk has never been used, you'll see a message asking
if you want to initialize it, otherwise, the disk’s icon and name
appears on the desktop. Skip to 3 in that case. For an unused disk,
type DYOH.Interiors2 for its name and click Continue. Next,
click ProDOS and 800k 2:1 to highlight the operating system
and disk size you need. Then click Initialize to start the
initialization. .

3. Once the initialization has completed, move the pointer onto the
original DYOH.Interiors disk icon, press and hold down the mouse
button, and drag the icon’s outline onto the backup disk icon.
Release the button. Read the confirmation message and click Ok.
If you have one drive, follow the on-screen messages instructing
you when to exchange disks.

4. When the copy process finishes, drag your original disk icon to
the trash can (that’s on the screen, not in your kitchen) and remove
the disk from the drive.

5. Click on the icon of your backup disk to highlight (select) it. Its
name is DYOH.Interiors2 if you did step 2 above using a blank
disk. Change the name by typing DYOH.Interiors and pressing
return. Don't use a different name. This name is used by the Finder
to associate Interior’s documents with the Interiors application.
Your backup copy is now ready to use (it doesn’t hurt to write-
protect it like you did your original disk).

Now that you’ve made a backup copy of your original program disk,
make a backup copy of the DYOH.SYSTEM disk and the Interiors
data (library) disk. Follow the same procedure as described above
to make the backups. However, use the system disk’s name (or data
disk’s name) and not the program disk name when you work through
the above steps.
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You should also create an additional data disk to store designs you
want to save. To do so, insert a blank disk, type an appropriate name
such as Interiors.Data, then click Continue and initialize the disk
as described in step 2 above. Once initialized, it’s ready for use. Please
refer to your Apple IIGS System Disk User’s Guide for additional help
in initializing and duplicating disks.

Remember, backup copies are only for your own safe keeping. It is
not legal to distribute copies of this or any other software without
written permission from the publisher.

Starting. Interiors

If you haven’t started the Finder or made a backup, then you need
to work through the preceding sections beginning with the “Getting
Ready” section before continuing.

Next, make sure the caps lock key is NOT pressed. This key has a
special function within Interiors. It's explained a little later.

To start Interiors from the Finder screen, insert your backup copy
of the Interiors program disk into your disk drive. Then move the
pointer onto the Interiors application icon and double-click. The ap-
plication icon has the name INTERIORS beneath it. If you have
trouble finding it, see the “Starting The Finder” section.

You can also start Interiors from the Finder and have a design that
you are working on automatically load for you. To do so, simply double-
click on the document icon above the name of the design that you
want Interiors to open. Once Interiors loads and starts, it will
automatically open the design. See the ‘Starting The Finder” sec-
tion for an illustration of the Interiors document icon.

Important: Read this if you started your computer from a disk other
than the Design Your Own Home system disk. Interiors requires the
5.0 version of the GS system disk. If you start the Finder from a ROM
disk, Hard Disk, or any disk other than the DYOH system disk, be
certain you are using GSOS before launching Interiors or it will not
operate properly.

When Interiors starts, the screen looks like this:
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The Interiors Desktop

You can arrange the whole desktop to suit your own needs. All the
windows are movable. To move a window, move the pointer onto its
frame or background area, press and hold the mouse button to make
an outline of the window appear, then drag the outline to a new loca-
tion. Release the button and the window moves to the new position.
The document window has precedence over other windows. If a win-
dow overlaps the document window, part or all of the overlapping
window may disappear beneath the document window. You may need
to move or re-size the document window to get to a hidden window.

As indicated above, you can change the size of the document win-
dow. Refer to the previous illustration. At the upper right corner,
there is a small box called the zoom box. Move onto it and click to
instantly enlarge the document window to fill most of the screen. A
second click restores the original window size. Use the box at the
lower right corner, referred to as a size box, to'expand or shrink
the document window to any size you want. To change the size, press
and hold the mouse button, then drag the window outline inward or
outward to the size you want and release the button.

The box at the upper left corner is called a close box and is describ-
ed later. Don’t use it yet.

Quitting Interiors

When you want to quit Interiors, first save your drawing to disk (if
you want a permanent copy), then select Quit from the File menu.
After Interiors quits, the Finder will start again. See the “Menus”
chapter for more about how to save your designs.

Making Interior Designs

Information in this section is provided in a general context only. Read
this section to gain insight into the overall design creation process,
then work through the “Trying Out Interiors” section for a hands-
on introduction to using Interiors.

The first thing you need to do to make an interior design is to create
a room. However, when Interiors first starts, a default room is created
for you. You can use it to become familiar with Interiors and refer
to the “Creating A New Room” section for detailed information about
creating your own rooms when you are ready. The default room is
a top view of a rectangular room consisting of four walls. You can
see it in the document window of the previous screen illustration (or
on the screen).

Next you’ll want to place doors, windows, and other furniture into
your room. The next section, “Trying Out Interiors”, shows how easy
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it is to place furniture into the default room. Normally, you'll place
and arrange furniture while viewing a room from the top. Then when
the top view is the way you want, you can change to side views (you'll
see more about this later).

Finally, you can do customizing or add finishing touches to your in-
terior design. For example, you may want to change furniture’s col-
ors, textures, or size. You can use the finishing tools (also explained
later) to customize the top or side views of your design.

Important: Customizing with the finishing tools should be the last
step in creating a design since it’s not possible to transfer finishing
tool customization to a top or side view. Additionally, the top view
of your designis the master view. All conversions to side views are
generated from the top view, so if you make changes to a side view,
they are not carried over to another side view or to the top view. You'll
see a message asking if you want to save changes to disk before a
view change is performed (i.e. when changes have been made using
the finishing tools, or when changes have been made to a side view).
You should save the changes at this time if you want to keep them,
they are discarded if you click No.

Trying Out Interiors

For an introduction to many of Interiors features, read through and
perform the following HANDS-ON exercises. Please refer to the
previous screen illustration as needed throughout the first part of this
section.

Placing Furniture

If you read the previous section, you'll remember that when Interiors
first begins, a top view of a rectangular room is created for you. For
now let’s use the default room and experiment with adding furniture
to it, but before continuing, get the command card that came with
Interiors and keep it handy as a reference. You’'ll see more about it
later.

The quickest way to add furniture to your design is to press the let-
ter that corresponds to the piece of furniture you want. For example,
go ahead and press the letter A to add an armchair to your room
(see your command card). The four squares at each corner of the
armchair are called handles. They indicate an object is selected. When
an object is selected, you can perform some operation on it, possibly
from the Edit or Adjust menus. This is explained in more detail later.

Now that you have added an armchair to your room, you can move
it to the location you want. Try moving it near (but not on) the top
wall. To do so, use the mouse to move the arrow pointer onto any
part of the armchair, then press and hold down the mouse button.

13




Notice a dotted box appears around the chair. Move the mouse to
position the dotted box slightly below the top wall and release the
mouse button. When you release the button, the chair moves to the
new location.

Now let’s place a framed picture on the left wall of the room. First,
press the letter P. Now, from the Adjust menu, select the Rotate
Left item. This changes the picture’s orientation so its front faces
to the right, which is what we need for placing it on the left wall.

You should note that when furniture is first placed in a room, the
front of the furniture is facing down. This is important to remember
when placing furniture so it will have the proper orientation when
you change to a side view of the room. For example, if you look at
your room from the right side, you want to see the front of the pic-
ture, not the back or side of it. Position the tip of the arrow pointer
onto the picture (between the handles—not on a handle), then press
the button and move the picture to any location you want along the
top of the left wall. Put the picture’s outline directly on top of the
wall and release the button.

Note: If you see a message saying that you can use handles to change
object sizes when using the finishing tools (all explained later), it means
you pressed the button on one of the picture’s handles instead of be-
tween the handles. Simply click Ok and try again.

Next, we’ll add a microwave cart and a microwave oven to the room
(these also double for a TV stand and TV). The microwave oven sits
on top of the cart. First, press the letter N to place the cart. Leave
the cart where it is. Now, hold down the option key and press the
letter N again. Notice that a different piece of furniture is selected
when you hold the aption key down. This is also true with the shift
key. By using option and shift with letters, 52 additional furniture
selections are possible.

Look at the height window at the left side of the screen and notice
under the letters Hgt at the top of the window that the microwave
defaults to a height of 2’8" off the floor. This is the approximate
height needed to make the microwave rest on top of the cart when
you change to a side view (approximate because sometimes a little
adjustment is needed after you change views). You can change the
height of the microwave, or any furniture that is selected, with the
scroll bar in the height window. For now, leave the microwave and
cart as they are.

Your command card lists all the pre-drawn furniture objects and what
letter keys to press for a given object. With a little use, you'll quickly
become familiar with the keys and can easily add furniture directly
to your rooms, or if you prefer, you can also choose furniture from
the Objects menu (the “Menus” section explains how).
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Changing Room Views

_If you have not done so, work through the previous section, “Plac-
ing Furniture”, before continuing.

Now that you have some furniture in the room, let’s see how everything
looks from various side views. At the bottom of the height window
on the left side of the screen, you'll see these icons for changing to
a different view of your room:

The box in the center represents the top view of your room and the
triangular icons surrounding it, side views. So to see a side view of
your room from the bottom (or south), go ahead and move the pointer
onto the bottom triangular icon and click. In a few seconds, the room
and furniture changes to the selected side view. You can add furniture
to side views (and move it) in the same fashion as you did on your
top view. However, the top view is the master view. All side views are
generated from it, so if you want to keep changes to a particular side
view, you need to save them to disk before changing to a different
view. This lets you customize each view to suit your own needs.

Now, view your room from the left by clicking on the icon at the left
side. Notice here that the picture you placed on the left wall does
not appear in the view. Furniture placed on top of an outer wall doesn’t
appear when you view your room from the direction of that wall. That
way, the back sides of furniture that is located on walls, such as win-
dows, curtains, etc., aren’t stuck in the middle of your side view. This
is important to remember. You shouldn’t allow furniture such as chairs
and sofas to overlap walls unless you don’t want them to appear in
a side view (when viewed from the direction of the outer wall they
overlap).

Next, move onto the icon on the right and click to view your room
from the right side. Now you see the picture on the opposite wall as
you should.

Go ahead and experiment changing to other views if you want. You
can click on the box in the center to change back to the top view
of your room. Before beginning the next section, change to a south
(bottom) view of your room again.
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Setting Furniture’s Height Above The Floor

This section continues where the previous sections left off. If you have
not done so, work through the previous sections before continuing.

Did you notice that the microwave appears on top of the microwave
cart in your side views. Its default height above the floor is set so that
it will. As with the microwave, all pre-drawn furniture that is above
the floor is set to a default height off the floor when Interiors starts.
You are not limited to the default height however, simply select a
piece of furniture (click on it), then go to the height window and set
its height as desired.

To demonstrate this, move the pointer onto the microwave and click
to select it. If it’s selected, four handles should appear at its corners.
Now, move the pointer onto the top arrow inside the height window.
Press and hold down the mouse button and let the height increase
several inches (the exact amount doesn’t matter), then release the
button. Notice the microwave is moved higher from the floor as it
is adjusted to the new height. You can set the height of any furniture
in the same fashion. However, if you set the height while viewing your
room from the top, the furniture won’t change position. Instead, the
new height is remembered and you’ll see the effect it has when you
change to a side view. If you move furniture in a side view, Interiors
assumes you are positioning it backward or forward in the room and
not changing its height from the floor.

If you want to, experiment more with using the scroll bar to adjust
the microwave’s height. The arrows adjust the height more slowly
and the shaded area above or below the box between the arrows more
quickly. Or, you can move onto the scroll box between the arrows,
hold the mouse button down, and drag the box upward or downward,
then release the button to change the height.

When ready, read on to see how you can customize interior designs
with the finishing tools.

Using The Finishing Tools

This section assumes you have worked through the preceding sec-
tions beginning with “Placing Furniture”. If you have not done so,
you should work your way here through the preceding sections before
continuing.

The finishing tools let you customize furniture or add custom draw-
ing, colors, patterns, and text to your room design. The finishing tools
include both drawing tools and color tools. To begin, select Use
Finishing Tools from the Options menu. When asked if you want
to save changes, click No since this is only an example room for try-
ing out Interiors. Note that even though we are currently working
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with the bottom view (or south view) of a room, it’s possible use the
finishing tools with any view. Just change to the desired view before
using the finishing tools.

After you select Use Finishing Tools, the height window disappears
and the finishing tools’ windows appear. Here is how the screen looks:
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Using The Selector Tool

The Selector Tool lets you select objects and change them, or move
them to a new location. You can select furniture objects or objects
you've drawn with the drawing tools (see the “Drawing Tools” chapter
for more about them). For now, we'll leave the furniture objects alone
and experiment with some of the finishing tools.

Begin by referring to the preceding screen illustration and select the
Rectangle Tool. To select it, move the pointer onto it and click.

Move into some blank area outside of your room, press and hold the
mouse button, then move the mouse to create a rectangle. Do the
same to create a second rectangle so you'll have two rectangular ob-
jects that look similar to these:

Exact locations and sizes aren’t important here. The rectangles will
only be used to explore some of the finishing tools. Now choose the
Selector Tool (click on it). Notice the last rectangle you drew has
handles at each corner like your furniture did earlier.

[]

The handles indicate an object is selected. Later you’ll see how you
can use them to change objects’ sizes. Don’t click anywhere in the
drawing area or you may unselect the rectangle and we need it selected
for now.

Move your pointer to the color palette and try clicking on various
colors and patterns. Notice how the interior of the selected rectangle
changes to the color or pattern you click on. It’s that simple to ex-
periment with various color or pattern combinations in your room
designs, whether it is with objects you draw, like the rectangles, or
existing furniture, like the armchair. Try holding the apple key down
when you click on a color or pattern. It lets you change an object’s
border color or pattern.

Now click on the transparent button (with the letters Trn) by the
top right side of the colors to show only the object’s border (i.e. make
it transparent). Click on any color or pattern to make the object solid
again.

18

You can change the border width just as easily by clicking on a dif-
ferent size in the line width window. Click on the widest line in the
line width window. Notice that the size of the rectangle remains the
same—only the width of its border changes.

To see how objects are unselected, click on a blank, or unused, area
inside the drawing window. The rectangle’s handles disappear. Select
it again by moving onto it and clicking. To select both rectangles at
once (or multiple objects), hold the apple key down and click on the
second rectangle. Now click on a color and notice both objects take
on the color. Any change you make (by clicking on colors, changing
line thickness, or whatever) affects ALL selected objects.

You can also ‘select multiple objects with a dotted box referred to
as a selection box. To do so, move the pointer beyond the top left
corner of the objects to be selected—the blank screen area outside
of any object, or in this case, outside of the two rectangles. Hold the
mouse button down and drag the resulting dotted box to the lower
right corner of the objects to be selected. Release the button. All the
objects that are within the selection box are selected and will have
handles. Click on any blank area of the screen to unselect all selected
objects.

As you've already seen, you'll often need to move objects to another
location. You can move one object or many objects at once. To move
the two rectangles you drew, select them both as described above.
Then move onto either rectangle. Press and hold the mouse button
and move the dotted outline of the objects to a new location. Release
the button. To move a single rectangle, first click on a blank area
to unselect both rectangles, then move the pointer onto the rectangle,
hold the button down and drag its dotted outline to a new position.
Then release the button.

Suppose you want to remove one or more objects from your design.
That’s easy. Just select the object(s) you want to delete, then press
the delete key or choose Clear under the Edit menu. You can delete
all objects by choosing Select All, then pressing delete or choosing
Clear. Undo will restore deleted objects if you don’t make any other
changes before selecting it.

You can perform many other operations on objects that are selected.
They are described in detail in other sections of this user’s guide.
In general, you can use items in the Edit, Adjust, and Text menus
on selected objects.

Go ahead and experiment with changing furniture colors and using
the finishing tools. When you are ready, read on to see how to create
a new room and learn more about other Interiors features. .
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Creating A New Room

There are basically two kinds of rooms you can create, a square,
rectangular-type room, or an irregularly-shaped custom room. To
create a rectangular room, you need only to specify a room’s dimen-
sions. To create a custom room, you can draw the room’s walls to
your liking.

Whichever kind of room you want to create, you can begin one of
several ways. You can go to the File menu and select New or Close,
or you can click on the close box at the top left corner of the docu-
ment window. Once you've used any of these methods, you'll see the
following dialog:

Ruom Size

wideh: [[H]ft [0 ]in
Depth: [1Z]ft [0 lin
Height:[7_1ft [0 lin

Max Size: 32' x 22*' x 10*
Min Size: U4' x Y4*' x 4y'

0 Ok ) [ cancel )

( Draw Custom Room )|

Creating A Square Or Rectangular Room

To create a square or rectangular room (after selecting New, Close,
or clicking the close box), simply type the dimensions of the room.
Use the tab key to move from one dimension box to another for typ-
ing, or click on a box to move to it. You can use the arrow keys to
move within the text inside a box and the delete key to remove text.

Click Ok to erase your original room and furniture and draw a new
room using the new dimensions, or click Cancel to retain your original
room and furniture.

20

Creating A Custom Room

To create a custom room, select New or Close from the File menu,
or click the close box, then click Draw Custom Room. The screen
changes and looks like this:

Click when done with room

l—CIick to keep original room and exit

Selector Tool ‘ R ' . Draw gour custom room
Line Tool o [ outline Ctop view).
e
o
o] \
i -
i3
i
<l

Notice that you now have two drawing tools below the menus near
the left side of the screen, the Selector Tool and a Line Tool, for
drawing and editing room walls. The drawing window contains rulers
and measurements so you can easily make the room any size you want.
You can also use some items from the Edit menu, such as Undo and
Clear, to aid in drawing an outline of your room.

The goal here is to draw an outline of your custom room by drawing
the walls to the appropriate lengths. You do not need to be absolutely
precise connecting the corners and making the walls straight. The
program will automatically scan the walls and connect corners which
you may not have exactly connected. It will straighten walls which
you may have drawn slightly crooked. Larger gaps or diagonal lines
are assumed intentional and left as they are. The Selector Tool and
the Line Tool work the same as when using the finishing tools. See
the “Trying Out Interiors” section and the next chapter, “Drawing
Tools”, for detailed information about them.

In general, to draw a wall, click on the Line Tool, move to the draw-
ing area, press and hold down the mouse button, and move the mouse
to drag a wall to the desired length and location, then release the
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button. You can click the Selector Tool and use it to move, lengthen
or shorten, delete, or copy walls (lines).

Once you've created an outline of your room, click Ok to keep it,
or click Cancel to exit and keep your original room. After you click
Ok, type the ceiling height you want for your custom room. Use the
tab and delete keys as needed and click Ok when the height is cor-
rect. Now, all your original walls and furniture are deleted and your
new room is drawn and ready for furniture, or ready to examine from
side views. You can select Change Room from the Edit menu to
change an existing room and keep existing furniture.

Interiors is designed to work with a single room at a time and not
an entire house or group of rooms. However, depending on your par-
ticular objective, you may be able to draw dividing walls or multiple
rooms and get the desired result. You'll need to draw the walls and
cycle through the various views (after clicking Ok) to determine if
the results are satisfactory. As mentioned above, you can use Change
Room to make modifications to existing walls. You also have the op-
tion of deleting walls, adding walls, and doing other customizing using
the finishing tools. In addition, there is room divider furniture which
may be useful in some rooms (you'll find these with the Other ob-
jects on your command card and under the Objects menu).

One more note about drawing custom rooms: when Interiors starts,
auto scrolling is enabled. That means when you draw a wall and go
beyond the bottom or right side of the drawing window, your draw-
ing is automatically scrolled to make more space for you to draw.
If you prefer, you can go to the Options menu and disable this feature
before you begin to draw a custom room.
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2—Drawing Tools

You can use the drawing tools to add custom drawing or text to your
room design. They are part of the finishing tools and appear in two
windows at the left side of the screen after you select Use Finishing
Tools from the Options menu. However, one tool, the Selector Tool,
is the active tool when viewing your room from the top and sides.
It’s used for selecting, moving, and manipulating your furniture. You
should read the “Selector Tool” section even if you don’t need the
other tools right away.

Here are the drawing tool windows:

Selector §f 4 }

Line

Hollow Line

Rectangle

Rounded Rectangle
Drawi Oval
Toatng Arc
Window Polygon

Sketch
Text

View Change Icons §-§

Line Width Window<|

The large window contains tools which let you choose the kind of
object you want to draw. The smaller window lets you choose the width
of lines or object’s borders. To make a tool active, or select a line
width, move the pointer onto it and click.
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Line Widths

A check mark indicates the current working line width. Lines and
objects’ borders are drawn with the current working width. If the Selec-
tor Tool is active, the line widths and border widths of selected ob-
jects are also changed when you click on a new width.

Selector Tool

The Selector Tool lets you choose objects for moving, re-sizing,
changing colors, border widths, or many other operations described
later in the “Menus” chapter. Though the Selector Tool becomes
visible as a tool only after selecting Use Finishing Tools, it is in reality
the tool that is active for selecting and placing furniture while view-
ing your room from the top and sides, so it’s best to read this section
even if you don’t have an immediate need for using the finishing tools.
Also, work through the “Trying Out Interiors” section for a hands-
on guide to placing and moving furniture, and using the Selector Tool.

Selecting Objects

When the Selector Tool is active, your pointer remains an arrow,
even when it is over the drawing window. The pointer’s hot spot,
the part that is used to determine what you have selected, is the tip
of the arrow.

To select a larger solid object, move the arrow onto it and click. When
choosing a small object among closely-spaced objects or lines, carefully
place the tip of the arrow exactly on the object you want to select
and click. If an object is transparent, place the tip of the arrow on
the object’s border and click.

Four small squares, called handles, appear at each corner of selected
objects (lines have a handle at each end). If you are trying to select
a small or transparent object and handles do not appear, re-position
the tip of the arrow and try again. When selecting among closely-
spaced objects, if handles appear on an object other than the one
you want, click on a blank area of the screen to clear the handles
and try again.

Note: In some situations, handles can cancel each other out. Handles
are drawn by reversing the colors on the screen under a given handle.
That way they can efficiently and quickly be erased by reversing the
colors a second time rather than by erasing the handles and redraw-
ing the objects. The only drawback is that occasionally two handles
may occupy precisely the same location. In this case, when the second
handle is drawn, it reverses the colors that were already reversed from
drawing the first handle. This has the effect of erasing the first han-
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dle instead of drawing a second one. The object(s) are still selected,
and treated as such, even though one or more handles may not ap-
pear. This happens infrequently and if you watch closely when it does,
you'll see the handles flash briefly on the screen indicating they are
actually being drawn.

Here are some examples of selected objects:

I.'\ | | C | ] E | | | |
s | | | | | ; ol \ IQI
You can hold the apple key down and click on additional objects
to make multiple selections. You can also select multiple objects with
a dotted box referred to as a selection box. To do so, move the pointer
to the top left side of the objects to be selected. Hold the mouse but-
ton down and drag the resulting dotted box to the lower right corner
of the objects to be selected. Release the button. If any portion of
an object falls within the selection rectangle, it is selected. Click on
any blank area of the screen to unselect all selected objects, or click

on an object without holding the apple key to select it and unselect
all others.

Features that need at least one object selected in order to work will
operate on all objects that are selected. For example, if two objects
are selected and you click on a color, both objects take on the color.

In general, items from the Edit, Adjust, and Text menus operate
on selected objects. In fact, most items in these menus remain disabled
(dimmed) and unusable until one or more objects have been selected.
Each item is described fully in the Menus chapter.

Moving Objects

When the Selector Tool is active, you can move objects by drag-
ging them to a new location. To do so, move the pointer over an ob-
ject, then press and hold the mouse button. When a dotted outline
of the object appears, move the outline to the new location of the
abject and release the button.

You can move several objects at once by selecting all the objects you
want to move, moving the pointer directly over any one of them, and
dragging the outline to a new location. All objects moved at the same
time will remain in the same configuration relative to each other.
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Sizing Objects
This feature applies only after you have selected Use Finishing Tools.

You can change the size of furniture objects or any other kind of ob-
ject then.

To change the size of a selected object, move the pointer onto one
of its handles. Press and hold the mouse button. When a dotted outline
of the object appears, drag the object to a new size. For example,
to enlarge a rectangle downward and to the right, use the handle on
its bottom right corner and drag down and to the right to the desired
size.

k d

\ Drag

Size an object back down by moving the dotted outline inward. Change
the size in other directions by dragging with a different handle.

Select Undo at the left side of the colors window or under the Edit
menu to reverse the last change made. Undo is described fully in the
“Menus” chapter.

Line Tools

The Line Tool and the Hollow Line Tool are for drawing straight
lines. As mentioned earlier, you can change the line width by choos-
ing a new width from the line width window below the tools. If the
Selector Tool is active, the line widths of selected objects are changed
also.

To draw lines, move the pointer to the starting point of the line, press
and hold the mouse button while moving the mouse to drag the line
to the desired end point, then release the button. You can draw straight
lines at perfect 45 or 90 degree angles by pressing the apple or shift
key before you begin the line.

To change the working color for lines (the color used to draw the
line), hold down the apple key and click on the color or pattern you
want for the line. Do the same to set the border color for hollow lines.
Click on a color to select the interior color for hollow lines (normally
white). This method of selecting colors is used for other objects as
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Well (see a complete explanation in the “Color Tools” chapter). Again,
if the Selector Tool is active, the colors of selected objects are also
changed.

Note: A hollow line does not become hollow unless the line size is
at least 3 dots high and it is transparent. As indicated above, you
can also fill hollow lines with patterns or colors.

Rectangle, Rounded Rectangle, Oval,
And Arc Tools

As their names imply, you can use these tools to draw rectangles,
rounded rectangles (rectangles with round corners), circles or ovals,
and arcs. You can change their border widths by clicking a new size
below the drawing tools. You can change their border and fill colors
or patterns the same way as described for lines above (see “Color
Tools” for more).

To use these tools, place the pointer where you want one edge of
the object to begin. Press and hold the mouse button, drag the ob-
ject to the size and orientation you want (you can drag any direction
from the start point), then release the button.

You can also make objects transparent (only their borders are drawn)
by clicking on the transparent button with the letters Trn at the
top right corner of the colors’ window. Click on any color or pattern
to make objects solid again.

Transparent Button

To draw arcs (you would normally draw these transparent - see above
for how), drag downward to draw the top part of a circle, and upward
to draw the bottom part. For example, you can create the following
arc by dragging down and to the right.

~

To draw perfect circles with the oval tool, squares with the rectangle
tool, or 90 degree arcs with the arc tool, press the apple or shift
key before you begin to draw.
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Polygon Tool

Use this tool to create a polygon, or many-sided, object. To draw a
polygon, move the pointer to its start point and click. Move to the
first line’s end point (and next line’s start) and click again. Continue
this sequence until you've completed the object by ending at your
original start point, or double click anywhere to end and have the
last polygon line automatically completed for you.

As with most other objects, you can change a polygon’s border width
or make it transparent.

The following are all examples of polygons:

e
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Sketch Tool

This is a flexible drawing tool used to create irregularly-shaped ob-
jects or regions. Here are some examples:

To sketch, move the pointer to the start position, press and hold the
mouse button, and move the mouse. Release the button to stop.
Remember, this tool still creates an object entity so it’s desirable to
end the sketch where you begin (as with polygons). If you release the
button elsewhere, the object is completed for you with a straight line
back to the start.

If you don’t want a border on your sketched object (or any objegt),
simply set the border color to the same color or pattern as the in-
terior color; by holding the apple key down and clicking on the col-
or or pattern you want for the border.
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Keep in mind that a good deal of memory is required to maintain
a sketched object. All its points must be remembered and redrawn
when the object is moved, or if it needs to be redrawn for any reason.
This can drastically slow the process of refreshing the drawing window.

It is wise to use this tool only when really needed, and to use the other
drawing tools instead when they are appropriate. When you need to
sketch, complete the bulk of your drawing first and draw the sketched
areas last so you aren’t burdened with slow window refreshes for your
entire drawing job. Also, the smaller the sketches, the better. If the
Polygon Tool will work, use it. Though not as fast as objects like
squares and circles, polygon objects still redraw much faster than
sketched objects.

Text Tool

Use this tool to add text or labels to your drawing. Move the pointer
to the spot you want to begin typing and click the mouse button. You'll
see a flashing bar cursor appear. Go to the keyboard and type your
text. Press the delete key if you make a mistake. When you have
finished typing, you can simply select a different tool. The text you
typed will be converted and kept as a single object.

If you want to continue typing but in a different location, use the mouse
to select the new location and click. The last text you typed is kept
as an object and you can begin typing a new text object as before.

You can press the return key to end a line of text and start a new
line below the previous line.

Select Choose Font from the Text menu to set the size, style, or
type of font you want for your text. You can make size, style, or font
changes to existing text by selecting it (with the Selector Tool), then
using the Choose Font item and making the desired changes. See
“Choose Font” in “Chapter 4” for a complete description.

Change the color of text by clicking on a color at any time while typ-
ing or before you begin typing, and for existing text, change the col-
or by selecting the text (with the Selector Tool) and clicking on a
color.
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3—Color Tools

The color tools are available after you select Use Finishing Tools
from the Options menu. Then, they appear near the bottom of the
screen and look like this:

,
Undo Anything Duplicate Color
Blend Color Swap Color

Border or Line Color Transparent Button
Working Color Mix Color
Click to Change Patterns

Color Tools Window

Each item in the color tools window is described in the following sec-
tions. Please refer back to this illustration as needed.

Selecting Colors

The current color (or pattern) selected for drawing is referred to as
the working color. The currently selected working color is shown
at the left end of the color palette.

To change the working color, click on the desired palette color or
pattern. If the Selector Tool is active, a click on a color will also
change the color of selected objects.

When drawing occurs, unless objects are transparent, the working
color is used to fill objects’ interiors. To change the border color of
objects, press the apple key before you click on a color or pattern.

The working color is framed by the working border color in the box
at the left side of the color palette. The lines in the line width win-
dow are also drawn with the working border color.

You can make the border color the same as the working color to create
objects without contrasting borders.
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Selecting Patterns

Patterns are selected and used the same as any color. They can be
used for object borders or fill colors. There are 48 patterns available
at any one time, and more can be created, saved to disk, and loaded
as needed. See the “Menus” chapter to find out how.

Sixteen patterns are shown in the color tools window. Click on the
working color box at the left side of the patterns to cycle through
the next sixteen patterns.

Undo Button

Undo was placed in the color tools window for quick, easy access.
This Undo works in exactly the same way as the one under the Edit
menu. Use it to reverse the last change made to colors or your draw-
ing. In most instances you can click it again to reverse the Undo also,
or toggle between the last change made and the state before the change
was made. When Undo is not available, it is dimmed.

Note that all other buttons in the color tools window relate to colors
only.

Dupe, Swap, And Blend Buttons

You can use the three buttons, Dupe, Swap, and Blend, in the col-
or tools window to change or arrange palette colors. Click on a but-
ton to highlight it (lighten its color) and activate it for use.

Note: The two colors on each end of the palette (black, dark gray,
light gray, and white) are reserved to maintain the integrity of the
screen display and windows. They are included in the palette so you
can use them in your drawing.

Dupe

Dupe (duplicate) lets you copy one palette color over another. To
duplicate a color: click on Dupe, move the pointer onto the color
you want to duplicate, press and hold down the mouse button, then
slide the color’s outline to the location where you want a duplicate
and release the button. Objects on the screen which were the destina-
tion color become the new color. Click on Undo to reverse the change.
You may duplicate one of the four reserved end colors (see the above
note) to another unreserved color location, but you may not move
a color onto any of the four reserved end colors.
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Swap

Use Swap to exchange the position of two colors without altering
either color. Each color is moved to the other’s position in the palette.
This causes objects on the screen which are drawn with the colors
to have their colors swapped also.

To exchange colors: click on Swap, move the pointer onto one of
the colors, press and hold the mouse button, then slide the color’s
outline over the color you want to exchange it with and release the
mouse button. You can click on Undo to reverse the change. The
four reserved end colors may not be involved in a Swap.

Blend

Blend is a feature that lets you create a series of intermediate colors
between two target colors (how is explained a little later). All the col-
ors between two target colors gradually blend from the first target
color into the second target color. For example, if you choose the
dark gray on the left side of the palette as the first target color and
the light gray on the right side as your second target color, all the
palette colors between them will turn to gradient shades of gray. Again,
the two reserved colors on each end of the palette may not be changed
by a blend, although a blend may include dark or light gray for a total
of 14 squares that can be involved in a blend, and 12 that can be
changed by a blend.

You can use Dupe or Swap to position target colors in the palette
before blending. For example, you might move red (with Dupe) next
to the dark gray color and place white four squares to its right, then
blend between the two for varying shades of red. Then you might
move green next to the last white target color, and put light blue 4
squares to its right, then blend between them creating 2 separate
blends in the palette.

To get the maximum number of intermediate colors from Blend, use
Dupe or Swap to move the target colors to each end of the 12
changeable color squares. Many more variations are possible. Go
ahead and experiment. You can always click Undo and reverse the
last change made, or restore the standard colors by selecting Default
Colors under the Options menu. Remember that objects on the
screen (and patterns) that were any of the original colors will take
on Blend changes also.

To Blend: click on Blend, move onto either one of the two target
colors that you want to Blend between, press and hold the mouse
button, slide the color’s outline to the second target color, and release
the button. Again, you can do repeated blending, and use Dupe or
Swap to arrange the color palette as desired.
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Changing Palette Colors Via Mix

To change the amount of Red, Green, or Blue (RGB) in a palette
color, click on the Mix button at the right end of the color tools
window.

A window will appear with 3 scroll bars. Click on one of the colors
in the palette to choose a working color. This working color will be
shown below the scroll bars. Use the scroll bars to change the col-
or's RGB mix, or level. Each Red, Green, or Blue level can range
from 0 to 15 for a total of 4096 possible colors. Click on the scroll
bar arrows to change the mix slowly. As the chosen working color
changes, you'll see the same color on the palette change, and also
any objects on the screen that are the working color will change.

You can click on another palette color to make it the working color
and change it, or when you're finished changing colors, click on the
mix window’s close box (or anywhere on the drawing window) to
remove the mix window.

Making Objects Transparent

The remaining color tool lets you draw transparent objects. Trans-
parent objects consist of borders without any interior fill color. You
can see through transparent objects—objects underneath them are
visible.

To draw transparent objects, move the pointer onto the transparent
button at the right side of the color palette and click. The button
has the letters Trn on it. Now objects you draw will be transparent.
Click on a pattern or color to draw solid objects again.
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4—Menus

This chapter describes the pull-down menus along the top of the
screen. To pull a menu down, place the arrow pointer on top of its
title, then press and hold the mouse button down. A list of menu
choices will appear beneath the menu title. To select a menu item,
continue to hold the mouse button down, then move the mouse
downward. Menu choices are highlighted as the pointer passes over
them. Release the mouse button to select the highlighted menu item.
Menu items you cannot use at the moment are dim. If you select a
dimmed item, a help message is shown informing you what is need-
ed for its use.

You can select many often-used menu items from the keyboard. Those
items are indicated with an apple symbol and a keyboard character.
Here are some examples:

u l aZ

ndo

Cut aXx
Copy aC
Paste av
Clear
Select All &R
Lock aL
Unlock U
Group a6
Ungroup GH
Info [#3 §

To make a menu selection from the keyboard, press the apple key
along with the appropriate keyboard character. In the above illustra-
tion, if you wanted to choose Select All, you would hold down the
apple key and press the letter A. Keyboard selections are perform-
ed just as if you had pulled down the menu and made them with the
mouse. You do not need to press the shift key if the character is on
the upper part of a key.

Apple Menu

The Apple menu (it’s an apple symbol at the upper left corner) con-
tains an About item and the names of desk accessories you can use.
These are explained next.
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About

This choice shows information about Interiors such as the copyright
date, the company that published it, and the programmer’s name.

Desk Accessories

Desk accessories are normally short programs you can choose that
do some specific task (like a clock, calculator, simple game, or puzzle).
A list of available desk accessories are added to the Apple menu.
Choose them like any other menu item.

The choices you have depend on what desk accessories are in the
SYSTEM/DESK.ACCS/ folder of the disk you used to start your
computer.

On the 5.0 and later versions of the GS system disk, Apple supplies
a Control Panel desk accessory. You can use it to change your Control
Panel’s settings (see “Appendix B” for help setting it for printing).
Contact your local dealer to learn more about it, or to get the latest
system disk and user’s guide.

File Menu

New

Select New when you want to erase your current interior design and
create a new room. You are given the opportunity to save changes
to your existing design (see Save below) or cancel before you begin
creating a new room. Refer to the section “Creating A New Room”
in the “Getting Started” chapter for details on creating the room.

Open
Open displays a catalog of the current drive and lets you load an ex-

isting interior design. You are given the chance to save your current
design if changes have been made (see Save).

Note: If a design has text objects (from using the finishing tools), In-
teriors tries to use the same fonts they were originally created with.
The same fonts must be available in the ISYSTEM/FONTS/ folder
of your startup disk so the Font Manager can load and install them.
If the Font Manager cannot load the desired font, the nearest match-
ing font is used instead.

Close

Close lets you erase your current interior design and create a new
room. Close and New are implemented identically by Interiors. Both
are included for completeness. As always, you'll have a chance to save
your current design if changes have been made since the last time
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you saved it. Refer to the section “Creating A New Room” in the “Get-
ting Started” chapter for details on creating a new room.

You can also click the close box at the upper left corner of the docu-
ment window to perform a Close.

To end your editing session, use Quit rather than Close.

Save

Choose Save to save a copy of your interior design to disk. If your
design is untitled, a dialog appears so you can name it. You should
give your interior design a unique name and not save it with Untitled
as its name.

If your design is already named because you have saved it during the
current session, or because you loaded it (with Open) from a library
or other data disk, you are not prompted for a new name. The cur-
rent name is used and the save is performed immediately. This lets
you quickly save an updated version of your drawing.

Warning: Any previous version of your design with the same name
will automatically be replaced with your current design when you use
Save. It’s assumed that you intentionally want to update the previous
version on your data disk. To protect a previous version, use Save
As (see below) to give your current interior design a different name,
especially when you want to save a different view of your design as
a separate file. You can use “.T”, “.N”, “.S”, etc., at the end of your
name for different views of your design (for top, north, south, east,
west).

Use Save frequently while you are creating a design so you'll always
have a recent backup of it stored safely on disk. To do a fast save,
hold down the apple key and press the letter S. Be sure to leave your
work disk in the drive so Interiors can save your design successfully.
If you remove your current work disk and insert a different disk and
select Save, you'll get a volume not found error since a complete
pathname for saving ProDOS files includes the disk (volume) name.
You need to use Save As to save to a different disk.

Frequent saves provide added protection in case a power failure oc-
curs or your computer quits working for any reason. If you update
your disk version often, you'll lose only a few recent changes and not
your entire design or hours of work.

Save As

Use Save As to save your interior design under a different name, or
to save it to a different disk or directory folder. You'll want to use
Save As to give different side views of your design their own unique
names and save them as separate files if you have customized them,
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or used the finishing tools on them. For example, you might use Liv-
ing.S for a room’s south view and Living.N for its north view. If you
don’t need any special customizing of side views, save only the top
view of your design. The top view is the master view and is always
saved with any other view. This means you'll use less disk space if
you save only the top view and use it to generate the side views the
next time you Open the design.

After the save, the name above the document window is changed to
your design’s new name. Any future saves with Save (above) are per-
formed using the new name.

You can use Save As to save a copy of important interior designs
on more than one disk for added protection in case one disk is in-
advertently damaged.

Revert

This reloads the last version of your design that was saved to disk.
You can use Revert if you've made changes since last saving your
design and decide you don’t want them. This choice remains dim and
unselectable until you make changes to an interior design after us-
ing Open or Save.

Scan

Scan lets you look at the interior designs in a disk’s directory. Select
Scan, then open any design in the specific directory you want to scan
by double-clicking on the design’s name, or click on its name and
on the Open button. When you open a file, it lets Interiors know
which “directory” you want to scan.

All the interior designs in the directory are shown sequentially. The
first design you see may not be the one you opened, but it will ap-
pear before the scan is finished.

A design is shown with the view that was current when the design
was saved. The name of the currently scanned design is shown at the
bottom of the screen. When you are ready to continue, click Previous
to see the design you saw prior to the current design, or Next for
the design following the current one, or click Quit to stop scanning.
You can also press the esc key to quit. If you go beyond the start
or end of the directory, scanning continues from the opposite end.

Save Paint File

To save your interior design as a standard unpacked Apple IIGS paint
file (file type $C1) that can be loaded by most popular paint programs,
and by the Paint Your Own Home program included with Interiors,
choose Save Paint File. ‘

You cannot reload designs that are saved as paint files so if you want
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to use your interior design again later with Interiors, be sure to also
save it the normal way with Save or Save As. Paint programs use
bit-mapped pictures, not objects you can select, move, and change
as with Interiors.

After you have saved your design as a paint file, you can select Quit
to return to the Finder, then launch Paint Your Own Home to work
with the paint file.

Delete

Use this to delete files that you don’t want on a disk. To delete afile,
click on its name, then click on Open. If the name is correct, click
Ok to perform the delete, or click Cancel to relist the files for another
selection.

After deleting a file, you can continue deleting more files, or click
Cancel, rather than on a file’s name, to quit.

Note: Delete lets you delete only files. If you open a folder, it’s opened
so you can see the files within it. A folder cannot be deleted using
Interiors. To delete a folder, quit Interiors and use the Finder. If a
folder is empty, no files are listed. Click Close to exit the folder.

Choose Printer

If you are using the latest system software (as you should be), you
can now use the Control Panel desk accessory under the Apple menu
to let Interiors (and the system software) know the type of printer
you have, and how it’s connected to your computer. If you use the
Control Panel desk accessory, you do not need to select Choose
Printer. For help setting the Control Panel, see “Appendix B”.

If you are using an earlier version of the GSOS system disk (earlier
than 4.0 will not work properly with Interiors), then you need to select
Choose Printer. Afterward, you'll see this dialog.

Choose Printer
Printer Type:

LASERWRITER

IMAGEURITER
EPSON
IMAGEWR. BY

Printer Port:

o] @B

MODEN
GRAPHICARD

=

QOhfippleTalk @ Direct Connect
User Nome: [ john Washington
D
R —_—
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AppleTalk. Select this as your printer port if you are using a
LaserWriter.

Direct Connect. Choose this option if your printer is connected direct-
ly to your computer.

User Name. Type your user name if you are using AppleTalk.

Select AppleTalk or Direct Connect as indicated above, then click
on the name of the printer and port you are using. Click Ok to keep
the new settings or click Cancel to retain your original settings.

Page Setup

Usg Page Setup to set the paper size and way you want your design
p}:mted. This is optional. Standard settings are used if you don’t change
them.

The ImageWriter Page Setup dialog looks like this:

IMAGEWRITER/PRINTER

Paper: @ US Letter
QUS Legal
QO Ry Letter
Q International Fanfold

Vertical Sizing: Printer Effects:

QO Normal [150% Reduction
@ Condensed  ["JNo Gaps Between
Orientation: Pages

1= —
B e

US Letter. This is the default paper setting. It’s for paper that’s 8%
by 11 inches.

US Legal. Use this option for paper that’s 8% by 14 inches.

A4 Letter. This option is for European standard paper. Its size is
8% by 11% inches (210 by 297 mm).

International Fanfold. This option is for the ImageWriter only. It’s
the International standard size of 8% by 12 inches (210 mm by 12
inches).

B5 Letter. This option is for the LaserWriter only (see the next dialog
illustration). Its paper size is 15 by 11 inches (250 by 176 mm).
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Normal. This setting prints designs with the same proportions they
have on the screen.

Intermediate. Use this to print designs approximately two thirds their
normal size (for the LaserWriter only).

Condensed. Designs printed with this option are about half their nor-
mal height. This option causes a design’s width/height ratios to distort,
so don’t use this option unless you have a special need for that effect.

50% Reduction. Designs are printed at half their normal width and
height.

No Gaps Between Pages. Printing is continuous without page breaks
when this option is selected.

Portrait. Designs are printed with the same upright orientation they
have on the screen.

Landscape. Select this option to print sideways (turned right 90
degrees).

Here is the LaserWriter dialog followed by options that differ from
the above descriptions:

LaserWriter

Paper: @ US Letter O Al Letter
QOUSLegal (O BS Letter
Orientation: Yertical Sizing:

 I=X QO Normal
QO Intermediate
smmmn] 1| @ Condensed
Printer Effects:
Reduce or
Smoothing? Enlarge: %
Font Substitution?

Printer Effects. These LaserWriter options are for bit mapped fonts
and are ignored.

Reduce or Enlarge. You can type a number from 25 to 200 to reduce
or enlarge your printout. A value of 100 is normal size (100% of im-
age), 200 enlarges a design to twice its size (100% X 2 = 200%),
and 50 reduces a design to half its normal size (100% / 2 = 50%).
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Print

Select this to set the number of copies you want to print, whether
to print in color, and to print an interior design. Before you print,
be sure to use the Control Panel desk Accessory or Choose Printer.
Otherwise, your computer may hang-up (see the “Choose Printer”
section and “Appendix B” for more).

This is the dialog you'll see for the ImageWriter:

IMAGEWRITER/PRINTER

Quality: O Better Text
N @ Better Color
QO Draft

Page range:

@1l
Ofrom:[ | 1Tu: []
Copies:

Paper Feed:@ Automatic O Monual

CIcoter

Better Text. This option doubles the printer resolution. It produces
the best quality text and lines. However, fewer colors are available.
Use this option when the quality of lines, black and white patterns,
and text is more important than a wider range of colors.

Better Color. More colors and better shades of gray are produced
with this option, but the printer resolution is lower than with Better
Text so lines are more coarse and text may not be as readable.

Draft. Don't use this option. It's used for dumping text straight to
the printer and isn’t used for graphic drawings.

Page Range. This option is ignored. An entire design is always
printed.

Copies. Type the number of copies you want to print. The computer
automatically moves the printer’s paper to the next page and prints
each copy (if Paper Feed is set to Automatic—see below).

Automatic. Used for continuous paper. The computer advances the
printer’s paper and continues to print if you are printing multiple
copies.
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Manual. If printing multiple copies, you are prompted before each
copy, and can continue to print or stop.

Color. If you have an ImageWriter II and a color ribbon, you can
select this option to print designs in color. An ImageWriter I can’t
print in color, so you shouldn’t use this option with an ImageWriter 1.

Here is the print dialog you'll see for the LaserWriter.

LASERWRITER/APPLETALK
Pages: @Al

O from: r—l To: [_—l
Copies:

Paper Source:
@ Paper Tray
(O Manual Feed

Pages. As with Page Range for the ImageWriter, this option is not
used.

Copies. Type the number of copies you want to print. If you need
to, use the tab key to move to the copies’ box to type a number (or
click on the box).

Paper Tray. You can use this option if you have a paper tray.

Manual Feed. Use this option for feeding single sheets of paper by
hand.

To Start Printing. Once you have all the Print options set as desired,
click Ok to start printing. Remember to make sure your printer is
on and ready for printing.

You can press the apple and period keys to stop printing in pro-
gress, or when a drawing has completely printed, press them to save
time and avoid waits for the printing sequence to end.

Be sure your computer’s Control Panel settings are set to the right
slots for your printer or your computer may hang up when you try
to print. See “Appendix B” if you need help setting the Control Panel.

If you decide not to print, click Cancel.
Quit

When you are completely finished using Interiors, select Quit. You
are given the chance to save recent changes before quitting.

42

»%

Edit Menu

All the choices under Edit except Change Room work with furniture
objects or custom drawn objects that have been selected with the
Selector Tool. Before using most of the menu items discussed here,
you must select one or more objects.

To select an object when using the finishing tools, click on the
Selector Tool to activate it (it’s the arrow at the top of the tools win-
dow), then move onto an object and click to select it. If you are not
using the finishing tools, simply move onto a piece of furniture and
click to select it. Press the apple key before clicking to select more
than one object at once.

For additional help selecting objects, do the “Trying Out Interiors”
section in chapter 1, and see “Selecting Objects” in chapter 2, “Draw-
ing Tools”. Also note that some items under the Edit menu are
available only when you are using the finishing tools and are dim
otherwise.

Undo

You can use Undo to reverse the last change made to your design,
or when using the finishing tools, the last change made to your color
palette also. In most instances you can select it again and reverse
the Undo. When using the finishing tools, this Undo works the same
as the Undo in the color tools window.

Cut

Cut removes objects from your design and places them in a clipboard
file. You must click on objects to select them before you choose Cut.
The current directory of the disk you used last is used for the clip-
board file. Any objects which were already in the clipboard file are
replaced.

Be sure the disk is ready and in the drive or the Cut will be unsuc-
cessful and an error will be reported. If you change your mind and
want to restore your objects, click Undo.

You can select Paste to put the objects back into your current in-
terior design, or open a different design and choose Paste to put
them into it (see “Paste”).

Copy

Use Copy to store a duplicate of selected objects in the clipboard
file. Click on objects to select them before you choose Copy. The
objects you copy replace any objects already in the clipboard file. Your
design is not changed. ‘
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You can select Paste to put the objects back into your current in-
terior design or another design at a later time (see below).

Paste

Choose Paste to copy all the objects in the clipboard file (on the disk
you used last) into your drawing. The objects are automatically selected
so you can easily move the pasted objects where you want them. Click
Undo to remove pasted objects.

Note: You cannot put side views of furniture into top views or top
views of furniture into side views. A message telling you this is shown
if you try. You can put any view of furniture or any other objects into
your design when using the finishing tools.

Clear

You can use Clear to remove objects from your design. In this case,
the objects are not placed in the clipboard. If you change your mind
and want to restore your objects, click Undo. You must click on objects
to select them before you choose Clear.

Select All

Choose Select All or press apple and the letter A to quickly select
every object in your drawing. You might want to do this to change
the border color, working color, or line width for all objects, or to
unlock, lock, move, or delete all objects at once.

Lock

First click on one or more objects to select them, then choose Lock
to keep them from being moved or changed. Locked objects cannot
be moved, grouped, deleted, or changed in any way (except with New
or Close for starting a new interior design).

Objects that are locked have a small key-like symbol above their top
left handle (after you’ve clicked on them to select them). The only
editing operation that will have an effect on locked objects is Unlock.

This feature can be quite useful. For example, you may want to lock
some furniture so you can arrange other furniture nearby without
accidentally changing the furniture objects you don’t want changed.

See the note below pertaining to room walls.

Unlock

First, click on one or more locked objects to select them, then choose
Unlock so they can again be manipulated and changed.

Note: Room walls are automatically locked. You can unlock and
change them after selecting Use Finishing Tools from the Options
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menu, or by choosing Change Room under the Edit menu.

Group

You can use this feature after you select Use Finishing Tools from
the Options menu.

Group converts a collection of objects that you have selected with
the Selector Tool into a single grouped unit. All the pre-drawn fur-
niture objects are examples of grouped objects. You must have more
than one object selected before you can use Group. For help selec-
ting objects, see ‘“Using The Selector Tool” in the “Trying Out In-
teriors” section of chapter 1, and also “Selecting Objects” in chapter
2 .

Objects’ screen coordinates and sizes are not changed by grouping
them. The grouped objects are treated as a single object until they
are ungrouped. This means if you select a grouped object, then click
on a color, all the individual objects within the group take on the color.

You can use Ungroup (below) to separate grouped objects and change
a single object within a group, then regroup them again afterwards.
This is important to remember because when you are using the
finishing tools, you can ungroup pre-drawn furniture objects and
customize them any way you like, or you can create your own custom
furniture objects and save them to disk for use in other interior designs
(see the “Objects” menu section for more).

Ungroup

This item is available when using finishing tools. It separates grouped
objects into their individual component objects. You need to click
on a grouped object to select it before choosing Ungroup. See
“Group” above for more.

Change Room

You can select Change Room to change an existing room’s wall
outline. This item differs from creating a new room in that existing
furniture is kept after you make changes to your room.

After you select Change Room, you’ll see the same dialog appear
as when you create a new room. However, the Draw Custom Room
button changes to Edit Custom Room. The options in the dialog
work the same as for creating a new room. If you change the room’s
dimensions and click Ok, you’ll get a rectangular room (even if you
previously had a custom room) set to the specified dimensions. If you
click Edit Custom Room, the editing screen and existing walls ap-
pear so you can change them as desired. See “Creating A New Room”
in chapter 1 for details on drawing and editing walls.
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When you've finished changing your room’s outline and go back to
the design screen, your original furniture is redrawn. However, you
may need to re-position furniture depending on the changes you made
to your room’s walls.

Note: If your room is a custom drawn room, and not rectangular,
the dimensions shown in the dialog text boxes represent the outside
boundaries of your room.

Adjust Menu

All the choices under Adjust work with objects that have been selected
and have visible handles. Work through the “Trying Out Interiors”
section of chapter 1 and see “Selecting Objects” in chapter 2 if you
need help selecting objects.

Move To Top/Bottom

These two choices let you rearrange the stacking order of objects
that you've selected. You can select an object and place it beneath
(or behind) another object with Move To Bottom, or move a selected
object in front of another object with Move To Top.

When viewing your room from the side, these items are dimmed. Fur-
niture objects in side views are automatically placed behind or in front
of other furniture objects according to their depth in the room.

Rotate Left/Right

When viewing your room design from the top, or when using the
finishing tools, use these menu items to rotate objects that you've
selected left or right 90 degrees.

In the case of side views, furniture is rotated left or right to its adja-
cent side view. For example, if you are looking at the front of a chair
and rotate it right, you'll be looking at the right side of the chair after
the rotate.

Note: The command key for selecting the Rotate Right menu item
from the keyboard is the vertical bar on the right side of the space
bar and NOT the letter I, which it might be mistaken for when pull-
ing the Adjust menu down. This means you can hold the apple key
down and press the vertical bar to select the Rotate Right item. The
rotate command keys are logically placed on the left and right side
of the space bar.

Flip Horizontal/Vertical

When viewing your room design from the top, or when using the
finishing tools, you can use these items to flip the orientation of
selected objects from left to right (horizontally) or top to bottom
(vertically).
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In the case of side views, Flip Vertical is dimmed and Flip Horizontal
changes to Flip Opposite, which flips a furniture object to its op-
posite view. For example, if you were looking at the front of a chair
and selected Flip Opposite, the front view of the chair would change
to a back view.

Text Menu

Items under the text menu let you choose the kind and size of text
you want to use, or let you rearrange text within your interior design.
However, Text menu items are finishing tool features and are dim
until you select Use Finishing Tools under the Options menu.

Choose Font

Use Choose Font to pick the font you want for typing text with the
Text Tool. You can also set the font’s size and style.

The changes you make are used the next time you type using the
Text Tool. If the Selector Tool is active and you've selected one
or more text objects, settings made with Choose Font also affect the
selected text objects. This lets you change the size, style, or font of
existing text.

After you select Choose Font, the following dialog appears:

Font:

Courier {
Geneva
Helvetica

Times

Venice O
Style: Size: g;her
BJPlain ize:
ClBold

O] 1talic

E Underline

Outline
CJ Shadow 9 Cox )

Font. When Interiors begins, the font for the Text Tool is defaulted
to the system font. The default system font is called Shaston.
Remember its name in case you want to use it again after you have
changed fonts. Its default size is 8, and its default style is Plain.

To choose a font, click on its name. The chosen font is highlighted
(darkened). If you need to, use the scroll bar arrows to scroll the list
of font names.

Note: The fonts yoﬁ can choose from are in the ISYSTEM/FONTS/
folder of the disk that you started your computer with. These names
are listed in the Choose Font dialog.
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Style. A font’s style refers to the way a font looks. Style choices in-
clude Plain, Bold, Italic, Underline, Outline, and Shadow. Here's
how they look:

Plain
Bold

ltalic
Underline
Dmeiline
Slhiald{ow)

You can use all the styles at once except Plain, which cancels all
other styles (it's plain). Also, Underline is not supported for the system
font, Shaston.

To select a style, click the box next to its name. A second click
unselects it.

Size. To select or change the size of a font, click on a number in
the Size catalog (the larger the number, the bigger the text), or type
a number in the Other Size box. The fonts look best at the cata-
loged sizes, but you can specify other sizes. The nearest matching
font is scaled to the size you want.

When all the settings are what you want, be sure your start-up disk,
normally the Interiors program disk, is in the drive so the Font
Manager can load the font you have chosen from the
ISYSTEM/FONT/ folder, then click Ok to install the new font and
use any size or style changes that you have made. If the Font Manager
cannot load the chosen font, it will default to the nearest matching
font it can find. Click Cancel to discard any changes and keep the
original font, size, and style.

Arrange

This menu item works with objects that have been typed using the
Text Tool and have been selected with the Selector Tool. It's dimmed
if no text objects are selected.

If you need help selecting objects, work through the “Trying Out In-
teriors” section in chapter 1 and see “Selecting Objects” in chapter
2. See the “Text Tool” section of chapter 2 for how to type and create
text objects.
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After selecting Arrange, the following dialog appears:

Arrange Text

Horzontal Vertical—,
Clas 1s As Is
ClLeft CTop
Center CJOcenter
CJRight [JBottom

Options in the dialog window are selected when an X appears in the
box beside them. Click on the box to select an option.

Horizontal Options. Use these options to arrange selected text
horizontally (left—right) on your interior design page, not just within
the document window. You can use See Full View under the Op-
tions menu to examine the results.

Use As Is to keép your text where it is horizontally or select Left,
Center, or Right to position text at the left edge, in the center, or
at the right edge of your drawing, respectively.

Vertical Options. These arrange text vertically (top - bottom) on
your drawing page. Here again, you can use As Is for no change,
or select Top, Center, and Bottom to position the text as desired.

Objects Menu

Just as the name of this menu implies, items under it let you choose
pre-drawn furniture objects. When you select these items, a dialog
appears so you can see and choose a specific furniture object (ex-
cept for some items related to custom objects—they are explained
later). Your choices will include only top views of furniture when you
are working with the top view of your room, side views of furniture
when you are working with a side view of your room, and all views
when using the finishing tools.

A box encloses the furniture object that will be chosen if you click
the mouse button. Move the mouse so the box encloses the object
you want, then click. Furniture is placed in the center of the docu-
ment window so you can easily move it to the location you want.
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Each letter on the keyboard corresponds to more commonly used
pieces of furniture. In addition, you can press option or shift and
a letter for another 52 furniture choices. To add furniture objects
to your drawing, simply press the letter corresponding to the object
you want. When possible, the first letter of an object’s name is used.
For example, C for chair or D for door. Sometimes option or shift
(or the previous or following letter in the alphabet) gives you another
version of the same object. For your convenience, a quick reference
card is included with Interiors showing what furniture corresponds
to what keys.

If you are working on the top view of your room and press a key to
add a piece of furniture to your design, you get a perpendicular orien-
tation of the furniture. You can get a diagonal orientation of the fur-
niture by pressing the caps lock key down before pressing the key(s)
for the furniture. In the case of side views, you get the furniture’s left
side rather than its front when you press caps lock down.

When a letter is pressed, the corresponding object is placed in your
interior design as described above so you can position it. Note that
when placing furniture into top views, the front is always facing
downward when the furniture is first added to your design. This is
obvious with a piece of furniture like a sofa, but isn’t with some fur-
niture. The China Top, for example, has an overhang at the top, so
when viewed from the top, the back looks identical to the front.
However, when viewed from the side, the front has drawers. You’ll
need to set the back/front orientation correctly so the furniture will
convert to side views properly. You can use the flip and rotate items
from the Edit menu to change furniture orientation, and it’s easy
enough to go back to your top view and change the orientation when
you find it is incorrect on a side view, or if you prefer, you can also
change the orientation on side views.

Other menu items let you create and save your own custom objects
for later use. The remaining choices in the Objects menu let you
choose custom objects, save new ones, clear (delete) them, or load
and save them to disk. Each of these are described below.

Custom

The remaining items in this section that work with custom objects
are finishing tools features. You can use them after you select Use
Finishing Tools from the Options menu.

Custom lets you pick a custom object and add it to your interior
design. However, before you can pick a custom object, you must create
some or load them from disk. See “Save To” below for how to create
your own custom objects. You can use the Load From Disk menu
item to load existing custom objects from disk (see below also). Your
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program disk has some sample custom objects that you can load and
experiment with.

Once you have created or loaded some custom objects, select Custom
to use them. The way you choose which custom object you want to
use is the same as the way you choose a pre-drawn furniture object.
When the objects you can pick from are drawn, use the mouse to
move the selection box and enclose the one you want, then click.
The chosen object appears in the center of the document window.
It is automatically selected so you can easily move it where you want
it (see “Moving Objects” in chapter 2 for help moving).

You can also select up to 26 custom objects from the keyboard. To
do so, press the control key and a letter. The letter A selects the
first custom object, the letter B the second, and so on. You can create
your own command cards, or lists, of which keys correspond to what
objects. You may select up to 26 custom objects in any one custom
object file, but you can have any number of custom object files and
load them from disk as needed, or you can select additional objects
by choosing Custom under the Options menu when there are more
than 26 objects.

After you choose Custom, if more objects are available than will fit
in the dialog window at one time, a More button is shown. Click on
it until you have seen all the objects or the one you want. When the
last object is shown, they are shown again beginning with the first one.

Save To

You can create your own custom objects and use Save To to save
them to memory. Once saved, select Custom (above) to use them
in your drawing as needed. If you want to keep your custom objects
permanently, be sure to use Save To Disk below before you quit
Interiors. You are given the chance to save new or changed custom
objects after you select Quit from the File menu. You can load custom
objects saved to disk and use them again later or in other drawings
with Load From Disk.

Save To lets you save only grouped objects as custom objects. To
create and save a custom object, you must first draw it. After select-
ing Use Finishing Tools under the Options menu, you can use any
of the drawing tools to draw a custom object, or you might modify
an existing furniture object and save it as a custom object.

Once your custom object is drawn, click on the Selector Tool. Now
select all the individual objects that make up your custom object so
you can group them into one object. Either press the apple key and
click on each object until they are all selected, or move the pointer
outside the objects, press and hold the mouse button, drag the dot-
ted box around all of the objects, then release the button to select
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them all. Once selected, choose Group from the Edit menu to group
them into a single object. Now you can choose Save To and save
your grouped object as a custom object.

You can use this feature to create your own libraries of custom ob-
jects that you can load and use in your interior designs as needed.

Clear Some

You can delete one or more unwanted custom objects. To do so, select
Clear Some.

Choose objects you want to delete the same way you choose them
to use in your design. Use the mouse to move the selection box and
enclose the object you want to clear, then click. Do the same to clear
more objects or click Cancel when done.

Warning: Use care clearing custom objects. You cannot recover an
object once it has been cleared!

Clear All

Choose Clear All to delete all custom objects. You are given a chance
to change your mind before the clear takes place. Be sure that you
no longer want any of the custom objects before you do the clear.
You cannot recover the cleared custom objects!

Load From Disk

Use Load From Disk to load custom objects from disk. You can load
the sample custom objects supplied on your program disk for ex-
perimentation, or load objects you created and saved with the Save
To Disk item described below.

Before the load occurs, you are given the option of clearing any ex-
isting custom objects or adding the objects you're going to load to
them. This lets you merge custom object files together or load more
than one group of objects at a time.

Once the objects are loaded, you can select Custom (see above) to
use them.

Save To Disk

To permanently keep custom objects you've created, use this menu
choice. The standard disk dialog will appear and let you name a file
for your objects.

You can create as many files of custom objects as you want and save
them for later use in your drawings.

Before quitting Interiors, be sure to use Save To Disk to save custom
objects you want to keep. Any objects that are not saved to disk are
lost when you select Quit or turn off your computer.
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Options Menu
See Full View

Select See Full View when you want to see your whole interior design
approximately as it will appear when printed on paper, but the quality
of a printout will be better than what you see on the view screen, and
the text will be more readable also. Click the mouse or press any key
to end the view.

Use Finishing Tools

This item lets you access drawing tools and colors tools for customizing
and adding finishing touches to your interior design. You can use
the finishing tools on any view of your design (i.e. top or side views).

To use the finishing tools, click on the view icons and view your room
from the desired view, then select Use Finishing Tools. The screen
changes and new windows with drawing tools and color tools appear.
An illustration of the finishing tools screen is shown in the “Trying
Out Interiors” section of chapter 1.

Changes you make to your design with the finishing tools cannot be
transferred to other views. However, you can save your finished design
to disk and Open it again later, then make additional changes to it
if you want, or change back to any of the other views as they originally
were before you made finishing changes. Side views are created from
your original top view.

You can work through the “Trying Out Interiors” section for some
hands-on experience with the finishing tools. You'll find complete
details on all the drawing tools, color tools, and on creating custom
objects in other chapters of this user’s guide. See “Drawing Tools”
in chapter 2 for a description of the drawing tools and help using
them. Read chapter 3, “Color Tools”, for help with those. Consult
other sections of this chapter, “Menus”, for information on creating
custom objects, using text, and editing patterns.

Show/Hide Rulers

Choose Show Rulers if you want visible rulers. When rulers are visi-
ble, this item changes to Hide Rulers so you can remove them.

Numbers on the rulers represent real-world distances in the scale you
are using (see “Scale”).

Show/Hide Measurements

This is a finishing tools feature. It is enabled after you select Use
Finishing Tools.
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When using the finishing tools and you select Show Measurements,
size information appears above the document window while you are
drawing or changing objects’ sizes. For rectangular objects, width
and height measurements appear. Length and angle measurements
are shown for line objects.

Performing calculations and updating the measurements does slow
down drawing so you'll want to use measurements only when they
are needed. You can find an existing object’s size by selecting it and
moving onto its lower right handle, then pressing and holding the
mouse button (when Show Measurements is activated).

After you choose Show Measurements, it changes to Hide
Measurements so you can remove the measurement display if it is
no longer needed.

Scale
When you choose Scale, the following dialog appears:

Scale
O1/gv =1 @ 1/y* =1

Drawing width: 32 ft
Drawing height: 22 ft

[CJRescale Objects

C ok 1) ( cCancel )

You can select Scale to change the scale of your design relative to
the real world, or to see what the current scale is. The round button
beside the current scale is automatically selected (darkened) when
the scale dialog window appears.

The current page size is also shown. Click Cancel to leave everything
as it is and exit, or read on to see how to change scales.

Scale. Click on the button beside the scale you want.

Re-scale Objects. Click on the box beside this option if you want
the size of objects changed (re-scaled) when you change scales. When
the box is empty, object sizes are not changed.
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Choosing a scale. You should do some planning before you choose
a scale. When Interiors begins, the scale is %" = 1’. This means
that when you print a hard copy, 1 inch on paper is equal to 4 feet
in the real world. Since a printed drawing is 8 inches wide. The max-
imum real world width of your drawing is approximately 32 feet using
the start-up scale (a little space is needed to allow for re-scaling ob-
jects before printing). In the default scale, a room can have a max-
imum ceiling height of approximately 10 feet, which leaves enough
room for a perspective side view of the room. The maximum ceiling
height is 20 feet in the 1/8” = 1’ scale.

If the project you are beginning will be larger than 32 feet wide, then
you need to cheose the 1/8” = 1’ scale. However, you should note
that the pre-drawn furniture objects will be smaller and more distorted
than with the default %" scale, but you can use the finishing tools
to make adjustments if you need to.

When the scale is what you want, click Ok to change to the new scale,
or click Cancel to discard any changes and stay with the original scale.

Note for LaserWriter users: Horizontal scale adjustments must be
made when printing to a LaserWriter. The adjustments are needed
to make drawings print to scale correctly. For this reason, approx-
imately one half inch is lost on the right side of the drawing page.
If you plan to do a LaserWriter printout, take this into consideration
and don’t draw right up to the right edge of the document window.
Leave an inch or so to allow for the horizontal scale adjustment. This
would mostly be of concern when using the finishing tools and needs
to be considered for the LaserWriter only.

Scale changing problems. Although Interiors can re-scale any ex-
isting objects when you change scales, it’s much better to choose the
correct scale before you begin drawing and stay with that scale. Due
to rounding, differences in line widths, screen resolution, and for other
reasons, objects may become misaligned and distorted to some degree
during the re-scaling process.

For the reasons listed above, if you try to re-scale an existing design,
you should always save a copy to disk as a safeguard first. Once ob-
jects have re-scaled during a scale change, you may not be able to
simply go back to the original scale and have them be as they were!
The next scale change re-scales objects based on their new, possibly
distorted, size and coordinates.

Auto Scroll

The Auto Scroll feature is enabled at start-up as indicated by the
check mark beside it. The effect of this feature is only noticeable when
using the finishing tools or drawing a custom room. While enabled,
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if you draw beyond the bottom or right side of the window, your draw-
ing is automatically scrolled. This lets you more easily draw objects
that are larger than the window viewing area.

If you don’t want to use Auto Scroll, select this item to disable it.
When disabled, you can use the scroll bars to scroll your drawing
if you need to. Click on the scroll bar arrows for small moves, in the
page area (beside the box) for larger moves, or drag the scroll bar
box to position your drawing as desired.

Patterns

If you are using the finishing tools, you can choose Pattern to change
existing patterns or to load patterns from disk. After selecting this
item, this dialog appears:

Click on Square to Edit

\‘
B NED N0 NN D B AR SN
L] lrl]lllllllllll
L] LlrlrlTlllllL‘J
o |
L] TII'IY‘IIIIIIIII
[ ] ) S N A S .
O] lllllllllllllll
[ [ [ | e e e
Working Color <{ . — L1 Click for
Working Pattern T ) Active Color
(Click for next m i i
page of patterns) ok (Cancel3 ng;;gezlicard
[ Save ) (_Load,) Quit Editing
7 .
Save Pattern to Disk Load Pattern from Disk

To edit a pattern, click on the pattern you want to change to make
it the working pattern, then click on the color you want to use. Move
the pointer onto the pattern square that you want to change and click
(in the large, fat pixel box on the left). You can hold the button down
and move the mouse for continuous drawing. Squares under the
pointer change to the working color. The reference area in the large
box on the right is updated for a true size perspective of your changes.

You can get the next page of patterns by clicking on the working
pattern square that’s next to the line of patterns in the palette.

To copy patterns, move onto the pattern you want to copy, then press
and hold down the mouse button. Move the pattern’s outline to the
new location and release the button. You can drag the outline off
the left or right end to copy to the next page of patterns.

Click Save to save a permanent copy of your patterns to disk, or click
Load to load patterns that you have previously saved.
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If you click Cancel, all changes made to the patterns are discarded,
the pattern dialog disappears, and your original patterns are restored.

If you click Ok, all changes to the patterns are kept, the pattern dialog
disappears, and your working patterns on the palette are redrawn
using the newly-changed patterns. Until you make other changes, you
can still click Undo to restore your original patterns.

Default Patterns

When using the finishing tools, this menu item initializes the palette
patterns to the default patterns, the same patterns that existed when
Interiors first began. Select Undo to reverse this selection.

Default Colors

When you are using the finishing tools, Default Colors initializes
the palette colors to the colors they were when Interiors started. Click
Undo to reverse this selection.

Memory

This item is provided so you can monitor your memory usage. The
amount of free memory available for use, the largest continuous block
of free memory, and the amount of memory currently used by your
interior design drawing are shown.

When the free memory gets below approximately 40K or the largest
block gets below approximately 25K, be sure to save a current copy
of your drawing to disk. If either of these values go much lower than
this, you'll see a dialog warning you that your memory is getting
dangerously low.

Save your drawing to disk, and it’s best to save a backup copy on
adifferent disk also. Then if you can, free up more memory by reducing
your RAM disk size if you are using a RAM disk. Remember to turn
your computer off and restart so the new RAM disk settings will take
effect.
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5—Using Paint Your Own
Home

While an object oriented program like Interiors is an ideal tool for
aging and arranging objects like trees and shrubs, there may be times
when you'll want to work with a design in ways that only a paint
program can. You can do things with paint layer drawings that you
cannot do with an object oriented program like Interiors. For example,
you may want to zoom in and edit your design at a single dot (pixel)
level, fill irregular areas with colors and patterns, or use various types
of paint brushes. For your convenience, we’ve included a program
called Paint Your Own Home (PYOH) with Interiors so you can save
designs as paint files and use paint-type features when you prefer.
In addition, Paint Your Own Home lets you load clip art screens. You
can create your own clip art or use the sample clip art that’s included
on the program disk.

Many of the Paint Your Own Home features, such as lines, rectangles,
and ovals work like they do in Interiors, except they draw paint layer
images rather than create objects. Features that are different or apply
only to Paint Your Own Home are explained here. When features
work the same, you are referred to other sections of this manual.

Starting Paint Your Own Home

Before starting Paint Your Own Home, if you have not already done
so, refer to the “Making A Backup” section and make backup copies
of the Interiors disks that you received.

Note: If you are already using Interiors, you can select Quit under
the File menu to return to the Finder. In this case, you do not have
to turn off your computer and start the Finder from scratch, so you
can skip the steps described in the following paragraph.

The first step to starting Paint Your Own Home is to start the Finder.
To do so, insert the Design Your Own Home (DYOH) system disk
into your drive, turn off your computer (if it is on), wait for about
30 seconds, and turn it back on again.

Once the Finder screen appears, if you have one drive, remove the
DYOH system disk from your drive and insert the Interiors program
disk. If you have two drives, insert the Interiors program disk into
your second drive. A window with the name DYOH.Interiors at the
top of it opens automatically.

If for some reason the window does not appear, you can open it
yourself. To do so, use the mouse to move the arrow pointer onto
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the disk (or volume) icon that has the name DYOH.Interiors beneath
it, then double-click the mouse button.

The Paint Your Own Home application icon is inside the DYOH.In-
teriors window (if you had to open the window yourself, you may
need to use the window’s scroll bars to find the icon). It has the name
Paint.Home beneath it and looks like this:

PAIHT.HONE

Paint Your Own Home drawings that you create and save to disk,
as well as clip art or any picture file that you can load appear with
adocument icon when viewed from the Finder screen. The Paint Your
Own Home document icon looks like this:

Y. HOHE

To start Paint Your Own Home from the Finder screen, insert your
backup copy of the program disk into your drive. Then move the
pointer onto the Paint.Home application icon and double-click.

Drawing And Color Tools

Many of the drawing tools and all of the color tools are the same as
those provided in Interiors. See chapter 2, “Drawing Tools”, for a
complete description of the drawing tools that are not described here
and refer to chapter 3, “Color Tools”, for a description of all the color
tools. When Paint Your Own Home starts, you'll see these drawing
tools:

Selector
Line |
Rectangle |
Rounded Rectangle |
Oval |

Arc
Polygon |
Sketch
Paint Brush }
Fill |

Zoom

Text |

HeorRNODD /M
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Though the hollow line tool isn’t visible in the tools window, it’s still
available. To use it, select the line tool, click the line width you want,
then hold down the option key while you draw.

Selector Tool

To use the selector tool, click the dotted box icon (the top tool). Now
move into the drawing window, press and hold down the mouse button,
and drag the resulting dotted box to the desired size. Then release
the button. :

The area enclosed by the selector box remains selected as indicated
by the animated box (it appears to flash or rotate). You can manipulate
the selected area with items under the Edit menu (see “Menus” in
this chapter), or you can use the mouse to move or copy the selected
area. You can press delete to quickly erase the selected area.

To move the selected area (or image), position the pointer anywhere
within the animated selection box. The pointer changes to an arrow
when it is within the selection box. Press and hold down the mouse
button and move the dotted outline to the desired location, then
release the button. The image is erased and moved to the new loca-
tion. To make a copy of a selected image, hold down the apple key
before you press the mouse button. The original image is left as it
is and a duplicate is copied to the new location when the apple key
is pressed. Select Undo to reverse the most recent change.

You have the option of having images drawn to the screen in either
of two drawing modes, replace or overlay. This applies to images
that are moved and copied, clip art images, and those that are pasted
into your drawing using Paste. The replace mode draws an exact copy
of the area that’s within the selection box, including any white
background area. The overlay mode causes white, the background
color, to be treated as a transparent color. So only colors other than
white, the foreground colors, that are within the selected area are
drawn (overlaid) to the screen. If you want white to be treated as a
foreground color and not be transparent, you can set a another palette
color to white with the Mix button and use it as a foreground color.
The only white that becomes transparent is the one at the right end
of the color palette (this applies to patterns as well).

When the program starts, overlay mode is used. You can temporarily
override whichever mode is active by holding down the option key
before you move, copy, or do any operation that draws a selected
image to the screen. You can also select Use REPLACE/OVERLAY
Mode under Edit to change the active mode. The new mode is used
until you change it again with the same menu item, or override it with
the option key.
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Paint Brush Tool

To use this tool, click the paint brush icon in the tool window. Move
into the drawing window, press and hold down the mouse button,
then move the mouse.

Additional paint brushes are available. To choose a brush, you can
hold the apple key down and press B, or select the Paint Brushes
item from the Options menu. Then move the selection box left to
right with the mouse and click the button to select the desired brush.

Fill Tool

This tool lets you fill an area with a color or pattern. To begin, click
the icon that looks like a paint can tipped to the left (with paint pouring
out), then click the color or pattern you want to use. Position the
center of the pointer exactly where you want the fill to begin and click.
If you fill a large area, it may take a few seconds to complete the fill.
You'll see a watch cursor indicating the program is working. If needed,
select Undo to reverse the fill.

Note: This is a vertically limited fill. This means the fill begins at the
point where you click and fills upward and downward until a color
different from the color you were on top of when you clicked is
encountered. Though you may need to click at more than one loca-
tion to fill complex areas with this type of fill, you can use this feature
to your advantage because you have a greater degree of control.

Zoom Tool

This tool lets you zoom in on (or magnify) your drawing. Each pixel,
or screen dot, is enlarged so you can easily see and change an in-
dividual pixel. To begin, click on the icon that resembles a tilted
magnifying glass. Now you can increase or decrease the magnifica-
tion by selecting a size in the line width window. You'll probably need
to use the scroll bars afterward to move to the area of your drawing
that you want to edit.

To draw, click on the color or pattern you want to use, move the
pointer onto the pixel that you want to change, then click. You can
also hold down the mouse button and move the mouse for continuous
drawing. Hold down the apple key and press W or select See Full
View under the Options menu to see your changes at their normal
size. Use Undo to reverse the most recent change.

Menus

All the Paint Your Own Home menu items under the File and Text
menus work as described for Interiors. Many of the items under Edit
and Options do also. Please refer to chapter 4 for a description of
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those. Menu items that apply to Paint Your Own Home only, or those
that are implemented differently, are described here.

Note: The Cut, Copy, Paste, and Clear items work as in Interiors
except the clipboard is maintained in memory rather than on disk.

Load/Get Clip Art

Use this item to load clip art screens. Clip art screens are standard,
unpacked, IIGS picture screens. You can draw your own clip art using
Paint Your Own Home (or any other paint program that lets you save
standard unpacked pictures), then use this item to load the images
for use in your drawing. If you need help using the load file dialog,
see “Open” in chapter 4.

After the clip art screen loads, it's shown on the screen so you can
select an image (or area) to add to your drawing. For future selec-
tions, you'll need to choose Get Clip Art.

To select an image, hold down the mouse button and drag the resulting
selection box around it just like you do when using the selector tool.
When you release the button, the image is placed in your drawing
and automatically selected so you can position it as desired. The selec-
tor tool is automatically activated also. If you don’t want to place any
clip art into your drawing, simply click without dragging the selec-
tion box around anything. This lets you use Load Clip Art without
immediately having to add something into your drawing, or lets you
select Get Clip Art for viewing only. Remember, you can selectively
use overlay or replace drawing modes to control how images are drawn
(see the “Selector Tool” section in this chapter). Undo removes an
image should you change your mind after selecting it.

Copy Drawing > Clip Art

This item copies your entire drawing page to the clip art page replacing
any clip art that is presently there. Select Undo to restore your original
clip art (before doing anything else).

If you are not using clip art, this is a handy feature for keeping a tem-
porary backup copy of your current drawing. It lets you experiment
by making multiple changes to your current drawing and use Copy
Clip Art > Drawing to restore your original if you don’t like the
changes.

Copy Clip Art > Drawing

You can use this to copy the clip art page to the drawing page. The
clip art replaces any current drawing. You can select Undo (before
doing anything else) to restore your original drawing.
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You might want to use Copy Drawing > Clip Art and this item to
save a backup copy of your drawing and later revert back to the backup
copy, or to transfer clip art to the drawing window so you can edit
it. Afterward, you could save the edited clip art with Save As and
use it at a later time.

Swap Drawing < > Clip Art

This menu item exchanges your drawing with the clip art page. You
can select Undo or this item a second time to restore both your drawing
and the clip art.

You can use this when you need to make minor changes to clip art
before using it with your current drawing.

Use REPLACE/OVERLAY Mode

Choose this to change the drawing mode that’s used to draw images
that are moved, copied, and pasted into your drawing (including clip
art images). The Use REPLACE Mode item changes to Use
OVERLAY Mode after it is selected (and visa versa) so you can change
to whichever mode is not currently active.

Please refer to the “Selector Tool” section near the beginning of this
chapter for a complete description of how these modes work.

Paint Brushes

This menu choice lets you change the paint brush that’s used for paint-
ing with the paint brush tool (the icon tool). To choose a brush after
selecting this item, use the mouse to move the selection box left or
right to enclose the desired brush, then click. The selected brush
is used the next time you use the paint brush tool. See the “Paint
Brush Tool” section of this chapter for more.
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Appendix A

Error Messages
No clipboard file

This error indicates there isn’t an Interiors clipboard file on the last
disk that you used. It may occur if you try to Paste before you have
used Cut or Copy. Use Cut or Copy to create a clipboard file and
place (cut or copy) objects into it, then don’t change disks before you
use Paste. If you need to switch disks, do it before you perform the
initial Cut or Copy since the working disk is used for the clipboard
file. You can make another disk the working disk by cataloging it
(with Open for example), then clicking cancel.

Object file 1/0

You'll see this only when Interiors first starts if no pre-drawn objects
can be loaded. You can click Ok and still have limited use of Interiors
(you can'’t use pre-drawn objects or change views but the finishing
tools are available). To avoid this error, if you've copied Interiors to
a different volume or Hard Disk, be sure the INTERIORS.DATA
folder resides in the same folder as the Interiors application and that
it contains a good copy of the INTERIORS.OBJS file.

Pattern file 1/0

You'll see this only when Interiors first starts if no patterns can be
loaded. You can click Ok and still have limited use of Interiors (the
default patterns for the pre-drawn objects will not be available). To
avoid this error, if you've copied Interiors to a different volume or
Hard Disk, be sure the INTERIORS.DATA folder resides in the same
folder as the Interiors application and that it contains a good copy
of the INTERIORS.PATS file.

A 1IMB + system is needed

This is shown at start-up if your computer doesn’t have enough free
memory for Interiors to start.

ProDOS (GSOS) 1/0

The operating system was unable to read or write data to disk. The
reason may vary. The disk may be physically damaged or have had
data on it compromised in some way.

Write protect

A disk is write protected and cannot be written to. Remove it from
the drive and disable the write protect tab. See Chapter 1 for how.
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Volume or Path not found

This might occur if you switch disks or remove a disk from the drive
and try to do a Save, Cut, or Copy. See the “No clipboard file” sec-
tion above and “Save” in the “Menus” chapter for related informa-
tion. Use Save As to save to a different disk.

Volume full

There is_n’t any more room on the disk. You'll need to save to a dif-
ferent disk or initialize (with the Finder) another data disk to use.
See the “Getting Started” section in Chapter 1 for help making data
disks.

Invalid direétory

The directory or subdirectory on the disk has probably been com-
promised. You'll likely need to use the Finder and copy all the files
you can to another disk, then initialize and verify the bad disk. Discard
the bad disk if it does not verify as being error-free after it is initialized
again.

Out of memory

You don’t have enough free memory to do whatever it is you are try-
ing to do. If you are using a RAM disk, you may be able to set it to
zero or reduce its size to free more memory. Be sure to turn your
computer off and restart after doing this.
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Appendix B

Setting The Control Panel For Printing
Using The Control Panel NDA

The latest version of Apple’s system disk lets you change Control Panel
settings using a New Desk Accessory (NDA) called Control Panel.
This section describes how to use it to set your Control Panel for
printing. For complete information about this desk accessory and
the latest system disk, contact your local Apple dealer.

If the Control Panel item is available under the Apple menu, select
it to set your Control Panel for printing, otherwise, see the “Using
The Control Panel CDA” section (below) for setting your Control
Panel.

When the Control Panel window appears on the screen. Click on the
icon for the type of printer setup that you have, DC Printer (Direct
Connect Printer) for an ImageWriter printer (or other printer that
isn’t on an AppleTalk network). You may need to use the scroll bar
to find the icon. Click on the name of the printer you have, and on
the port it’s connected to at the back of your computer. Don’t write-
protect the DYOH system disk so the settings you choose can be saved
to disk, then you won’t have to do this the next time you start Interiors.

Now find the Slots icon and click on it (use the scroll bar if needed
to find the icon). To change a slot, move the pointer onto the box
beside its number, hold down the mouse button and move the mouse
to select the desired option then release the button. Use this pro-
cedure to set slots 1, 2, and 7 as appropriate for your hardware setup
(see #4 in the “Using The Control Panel CDA” for more help with
slot settings if needed). Click the close box at the top left corner of
the Control Panel window when finished.

Note: When using the Control Panel desk accessory, the options
shown in italics are the default settings. The Alphabet keyboard
translation must be set to None (if not already). This is how the GS
translates characters and it’s required for the option key to work cor-
rectly with Interiors. The Standard setting is how the Macintosh
translates characters.

Using The Control Panel CDA

This section helps you set the Control Panel for printing. If you have
already started Interiors, you'll need to save any existing design since
you'll have to restart your computer after working through this sec-
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tion. Please consult your Apple IIGS Owner’s Guide for more infor-
mation about the Control Panel.

1. If your computer is on, press the apple, control, and esc keys
simultaneously to access the Desk Accessories menu. If your com-
puter isn’t on, hold down the option key and turn it on, then at
the resulting menu, press 1 and go to step 3.

2. Use the up or down arrow key to highlight the Control Panel item
and press return.

3. Use the up or down arrow key to highlight the Slots item and press
return.

4. Now, use the arrows to highlight Slet 1 if your printer cable is
plugged into the printer port at the back of your computer, or Slot
2 if it is plugged into the modem port.

5. Use the right arrow key to change the highlighted slot as follows.
Set Slot 1 to Printer Port if your printer is connected to the printer
port. Set Slot 2 to Modem Port if your printer is connected to
the modem port. Set the highlighted slot to Your card and Slot
7 to Built-in AppleTalk if you are using a LaserWriter or an Ap-
pleTalk network (a LaserWriter uses an AppleTalk network setup).

6. Press return to keep the new settings, highlight Quit and press
return again to exit.

7. Turn your computer off and wait about 30 seconds before turn-
ing it back on. You need to turn your computer off to initialize
the system with the new Control Panel settings. Refer to the “Get-
ting Started” section for help in restarting.

67




Appendix C
Setting Your RAM Disk To Zero

Interiors requires a minimum of 1024K (1MB) of free memory to
operate, so to ensure enough memory is free, set your RAM disk size

to
1.

zero. The following steps show you how.

If your computer is on, press the apple, control, and esc keys
at the same time to access the Desk Accessories menu. If your com-
puter is off, hold down the option key and turn it on.

. If you began with your computer off, press 1 to select Control

Panel. If your computer was on, then at the Desk Accessories menu,
use the arrow keys to highlight Control Panel and press return.

. Use the up and down arrow keys to highlight RAM Disk and press

return.

. Use the right and left arrow keys to set both the minimum and

maximum RAM disk sizes to zero and press return.

. Turn off your computer so the new settings will take effect. Now

you can start Interiors as described at the beginning of this user’s
guide.
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Appendix D
Installing Interiors On A Hard Disk

1.

Use the Finder to copy the Interiors application file to the desired
Hard Disk folder. You can use an existing folder or create a new
folder.

. Copy the entire Interiors.Data folder that resides on the program

disk (not the data disk) to the same folder on the hard disk that
contains the application file.

. Copy the Interiors.Icons file inside the Icons folder of the original

Interiors program disk to the Icons folder of the boot volume on
the Hard Disk so the Finder will use the Interiors program and
document icons if you boot from the Hard Disk.
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Side Views of Sample Rooms

Appendix E

Living Room 1

Living Room 2

Large Living Room 1
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Kitchen 2

Large Kitchen 2

Dining Room 2
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Office Suite 2
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Appendix F

Extra Copies of Command Cards

K|TCHEN GS Interiors

ot KEY DIMENSION TOP
OBJE Depth  Width Height
(Distance from floor) VIEW
Cabinet Drawers K 24 18 36 O
Cabinet (high) Opt-K 14 18 30 O
(4/6")
Cabinet (ow) Shf-K 24 18 36 O
Counter End Opt-J 24 12 36 D
Dishwasher | OptD 24 24 36 7
Freezer Opt-F 28 48 32 ]
Microwave/TV 20 26 32 i
Work Area 3 v Cart N o
Microwave/TV Opt-N 20 26 16 i
(2'8", sits on cart)
Refrigerator Opt-R 28 24 60 O
Sink (aby) J 24 48 36 @]
Range Shf-R 24 3 36
Table Opt-G 48 48 30 []
——

CAPS LOCK DOWN: Diagonal of object on top view
Work Area 4 : Left side on side views

78 79




LIVING ROOM GS Interiors DINING ROOM GS Interiors

DIMENSION TOP DIMENSION TOP
OBJECT KEY Depth  Width Height ECT KEY Depth  Width Height
(Sistance from flzior) VIEW OBJ (Distance from floor) VIEW

Armchair A 28 28 30 O Buffet Opt-H 17 44 32 —
;j Coffee Table Shi-E 20 48 15 — Cabinet (nigh) Shf-| 14 (352,) 30 -
Fireplace F 5 48 36 — China Top Shf-H 17 44 40 -
| (2’6", sits on Buffet)

Lamp L 16 16 28 (©) Cupboard Shf-J 18 40 68 (-

(1’6", sits on E. table)
Ottoman 0] 26 26 18 O Light (hanging) Shf-L 24 (2;1 ) 24 o
5/ ”n

Piano Shf-A 60 56 40 b Table 1 T 40 56 28 [[]]

Recliner R 3 30 37 Table 2 (round)* OptT 48 48 28 O

Sofa S %2 72 36 Table 3 (rounded) ShiT 40 56 28 D)

Modular Sofa Opt-S 34 22 30 g CAPS LOCK DOWN: Diagonal of object on top view

: Left side on side views

Modular Sofa End | Shf-S 34 28 30

Wood Stove Shf-Q 28 20 28 0

End Table 1 E 32 22 26 D

End Table 2 Opt-E 32 22 18 ﬁ

Game Table G 32 32 28 O

80 81




BEDROOM GS Interiors BATHROOM GS Interiors

DIMENSION
DIMENSION
OBJECT KEY | Desn Wian Hegn | TOP NSION TOP
| (Distance from floor) VIEW OBJECT KEY [()l;ips(tham‘:’:"fjrtgm ';g'g:)" VIEW
Bed (double) B 60 80 40 Bathtub 1 v 32 60 16 -
Bed (singe) Opt-B % 80 30 [ Bathtub 2 OptY 52 52 16
Beds (bunk) Shf-B 39 80 68 ]-J Bathtub 3 . Shiy 52 52 18
| Dresser (double) Opt-U 20 52 33 O Hamper H 16 24 30 O
Dresser (single) U 20 32 38 = Mirror (ighted) Shf-M 5 3 36 -
(2’6", sits on Sink 2)
Table (bedside) Shf-U 18 20 28 O Shower 1 Opt-X 30 30 76 X
Vanity Optv B 52 28 O Shower2 Shf-X 32 30 76 e
Vanity (wmirror) \Y 21 52 42 o4 Sink 1 z 22 34 33 ©
CAPS LOCK DOWN: Diagonal of object on top view Sink 2 Opt-Z 22 3 34 x
: Left side on side views
Sink 3 Shf-Z 33 36 36
Toilet Shfv 24 20 28 oy
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OTHER GS Interiors OTHER GS Interiors

| OBJECT KEY | own Wan Augn | TOP cT o Wi Hogn | TOP
5 epth Width Height KEY Depth Width Hei
: (Distance from floor) VIEW OBJE (Igipstancelfrtom ﬂzfrr;( VIEW
* Bar, Stools Shf-G 38 48 36 -] Plant (potted) Opt-O 19 16 18 o
(1’6", sits on E. table)
g Bookcase Opt-A 2 32 38 & Plant (hanging) Shf-0 12 12 28 K
! (5'6")
Chair 1 C 22 20 33 ad Poster, Mirror Shf-P 1 22 33 -
(3’6”)
Chair 2 Opt-C 16 20 36 O Rocking Chair Shf-C 28 26 40 i
Curtain X 5 19 42 = Computer/TV Shf-N 20 20 20 g
(2'8") (2’6", sits on desk)
Desk Shf-D 30 60 30 [ Window 3 (picture) Shf-W 3 62 42 —
(2'8")
Door D 3 36 80 — Window 1 (framed) W 3 20 30 —
+ (3!6”)
Ceiling Lt Fixture Opt-L 12 12 9 0] Window 2 (plain) Opt-W 1 25) 36 -
(6/6/’) (37
Light 2 (hanging) | 16 16 24 0] File Cabinets Shf-F 26 14 28 [
(5'5")
Lamp (fioor) Opt-| 16 16 56 0] Room Divider 1 Q 3 %6 72 e
Mirror M 13 18 — Room Divider 2 Opt-Q Y R —_—
(69
Round Mirror Opt-M 1 20 20 — ‘ CAPS LOCK DOWN: Diagonal of object on top view
(69 : Left side on side views
Picture (framed) P 1 14 18 -
(4!6")
Picture, Mirror Opt-P 1 (24) 16 -
&
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MENU COMMAND KEYS

C3A = Select All U = Unlock
(3B = Move to Bottom 3V = Paste
@C = Copy B W = View
3 F = Choose Font B X = Cut
3G = Group 3Z = Undo
3 H = Ungroup 3~ = Rotate Left
3K = Close 3| = Rotate Right
3L = Lock 3" = Flip Horizontal
@M = Show/Hide &: = Flip Vertical
Measurements
N = New
30 = Open
aP = OBJECT GROUPS
ca = Qu 31 = Living room
aR - g:ﬁ::smide ¢312 = Dining room
(3S = Save 33 = Bathroom
3T = Move to Top (34 = Kitchen
(35 = Bedroom
36 = Other
30 = Custom
3 + = Save to
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Other Abracadata Products

Adventure of Learning: The revolutionary educational program for
home and school. Runs or creates Learning Modules, Learning Adven-
tures, and Entertainment Adventures.

Design Your Own Train, the first transit system construction set
that puts a model railroad inside your computer. For all Apple II's
(GS too), IBM/compatibles; and for the Macintosh, MacInooga
Choo-Choo.

Train Library, Includes a dozen complete ready-to-go layouts will
work with Design Your Own Train or Run Your Own Train. For Ap-
ple II, IBM, Macintosh. '

Run Your Own Train, the “flight simulator” for down-to-earth
people, puts you in the engineer’s seat as you run trains over layouts
that you design yourself. For all Apple II's (GS too). IBM version
coming.

Everybody’s Planner, project management and flowcharting for all
Apple II's (GS too) and IBM/compatibles.

Everybody’s Planner Reports, provides 13 extra reports for above,
all Apple II's (QS too) and IBM/compatibles.

Design Your Own Home, Architecture, Interiors, Landscape design,
all Apple II's (GS too), Macintosh, IBM/compatibles, special IIGS ver-
sions available.

Design Your Own Home Libraries, 4 Architecture, 2 Interiors, 1
Landscape library, each with 48 complete plans. 7 libraries for each
computer: Apple II, IIGS, Macintosh, IBM/compatibles.

Landscape Regional Image Libraries, enable you to insert regional-
spec1ﬁc trees and other landscape items into your landscape plan.
Five libraries for Apple I, IIGS, IBM.

Welcome!, organizational handbook for any type of organization,
for all Apple II's (GS too).

EIectroz?ic Drawing, 98 pre-drawn shapes make electronic
schematics a breeze, all Apple II's (GS too) and IBM/compatibles.

Grf'tphics Supermarket, 1IGS shape utility, creates and saves shapes,
animates and (programmers!) provides source codes for the shapes;
prints; special developer’s version available with complete program
source codes (C and assembler); IIGS.

Write or call us for
more information. Abl"a Cadata

the source of plan-making software

PO. BOX 2440
EUGENE, OR 97402
(503) 342-3030
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LIMITED WARRANTY,
DISCLAIMER OF WARRANTIES,
AND LIMITATIONS OF LIABILITIES

Abracadata, Ltd. warrants to the licensee and no other person or entity the disks on which DESIGN YOUR OWN HOME,
INTERIORS are recorded (but not the software nor this manual) to be free from defects in materials and workmanship
under normal use for a period of 30 days after the date of original purchase. If during this 30-day period a defect should
occur, the disk may be returned with a copy of your dated sales receipt and a brief description of the problem to Abracadata,
Ltd. P.O. Box 2440, Eugene, OR 97402, for replacement free of charge. Your sole remedy in the event of a defect
in a disk is limited to replacement of the disk as provided above. Any implied warranties applicable to the disk shall
terminate not later than 30 days after the original date of purchase. If the disk has been physically damaged, is beyond
the 30 day limit, or is not accompanied by proof of purchase, include $10 per each disk plus $4.00 postage and handling
per request. Please return the disk only, not the entire package. Do not staple or paper clip the disk. Package the disk
carefully to prevent bending, and mark the package “Do not X-Ray or Use Magnets.” Ship via UPS or U.S. Postal Ser-
vice with return receipt requested. Abracadata, Ltd. is not responsible for disks not received when you cannot provide
proof of your shipment and our receipt.

DESIGN YOUR OWN HOME, INTERIORS is sold or licensed on an “as is” basis. Except as provided above with respect
to the disks, Abracadata, Ltd. makes no other warranty or guarantee of any kind, express or implied or statutory, with
respect to DESIGN YOUR OWN HOME, INTERIORS, it quality, performance, accuracy, merchantability, or fitness
for any particular purpose; and assumes no responsibility or liability to the licensee or any other person or entity with
respect to any damage caused or alleged to be caused by use of DESIGN YOUR OWN HOME, INTERIORS. The entire
risk as to the quality, suitability, accuracy and performance of DESIGN YOUR OWN HOME, INTERIORS is with the
licensee. Except as provided above with respect to the disk, if DESIGN YOUR OWN HOME, INTERIORS proves defec-
tive after purchase, the licensee (and not Abracadata, Ltd., its distributor, its retail seller or others involved in the develop-
ment of the product) assumes the entire cost of all necessary servicing, repair, or correction. In no event will Abracadata,
Ltd. be liable for direct, indirect, incidental or consequential damages resulting from any defect in DESIGN YOUR
OWN HOME, INTERIORS or from any particular application of DESIGN YOUR OWN HOME, INTERIORS by the
licensee or any other person or entity, even if Abracadata, Ltd. has been advised of the possibility of such damages.
Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential
damages, so the above limitation or exclusion may not apply to you. If any exclusion or limitation shall be determined
by a court to be invalid or enforceable, the determination shall not affect in any respect the validity or enforceability
of remaining exclusions or limitations or of the same exclusion or limitation in different circumstances.

Abracadata, Ltd. gives no assurance that the information used in the development of DESIGN YOUR OWN HOME,
INTERIORS is reliable and accurate. The recommendations by DESIGN YOUR OWN HOME, INTERIORS represent
only the opinion and judgment of the author and are intended to be applicable in normal circumstances. Individual
circumstances may vary and may render certain recommendations inapplicable. AL gives no assurance that the opin-
ions of judgment of the author are reliable and accurate.

If you have read the manual and you are having
trouble with the program, please follow the
procedure below to get help.

1. Read ALL of the enclosed sheets (if any) included in the program box.

2. Contact your dealer for further information and help with the operating system and finder. This pro-
gram works only with the operating system supplied with it.

3. Did you mistakenly erase your data disk?

If you’re sure you've done everything correctly (or you're positive you've erased your data),
read the first paragraph of the Warranty statement, above.

Then, before you do anything else, CALL us for assistance. If we determine that there is
something wrong with your disk, we'll give you a Return Authorization number for a return, and
will instruct you regarding payment if you are beyond the warranty period.

And Be Patient...






